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Upgrade overview

This overview provides information about Microsoft Dynamics AX 2012 upgrade changes and
requirements. The following sections are included.

T What's New: Upgrade

i Supported upgrade paths

1 Hardware and software requirements
9 Best practices for upgrade
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What's New: Upgrade

Microsoft Dynamics AX 2012 provides a new approach to upgrade that significantly reduces your
companyds downtime during the upgrade process. Shorter
operations and a lower total cost of upgrade.

Source-to -target upgrade model

Microsoft Dynamics AX 2012 uses a sourceto-target upgrade model that allows business users to work
with maximum efficiency during upgrade. In previous versions of Microsoft Dynamics AX, dl upgrade
tasks were carried out on a single production system. A substantial part of the upgrade process was spent
in single-user mode, and during that time the system was offline for regular users. Difficulties that arose
during upgrade had to be resolv ed under time pressure before normal business operations could resume.
Now, with Microsoft Dynamics AX 2012, you preprocess your business data on thesourcesystem (running
Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009) while the system is livefree from time
pressure and without halting normal operations.

Meanwhile, you build your separate, offline target system (running Microsoft Dynamics AX 2012). When
preprocessing on the source system is complete and the target system is ready, you entersingle-user
mode on the source system, bulk copy your data into the target system, run post-synchronization
upgrade scripts, and perform testing. At this point the target system can go live.

The following diagram shows the phases of upgrade in the source-to-target model.

online
SOURCE Preprocess data :iTEI:a—
SYSTEM P g
user mode offline
TARGET Prepare system il bz GO LIVE
SYSTEM pare sy finalize, test

The source system (Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009) remains online during
data preprocessing, and then goes offline when you enter single-user mode to prepare the data for bulk
copying. When the target system (Microsoft Dynamics AX 2012) has been installed and code
customizations have been applied, you bulk-copy the data into it, run post -synchronization scripts,
perform final configuration tasks, test, and finally go live.
7 Tip:

Source-to-target upgrade require s the source system and target system to be installed on

separate server computers. Sideby-side installation on a single computer is possible, but should

only be used for testing purposes. For more information, see Hardware and software

reguirements.
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Checklists for each stage and type of upgrade

In previous releases of Microsoft Dynamics AX, which implemented upgrade on a single computer system,
a single upgrade checklist contained all of the core upgrade tasks. Under the sourceto-target upgrade
model, there are now several checklists and related forms to help organize upgrade tasks on the source
and target systems.

Checklist Description

Preprocessing upgrade checklist Tasks preparing data on the sourcesystem for the Microsoft Dynamics AX 2012
database schema.

AOD code upgrade checklist Tasks involved in migrating code customizations in legacy AOD files to the
Microsoft Dynamics AX 2012 model architecture.

Model code upgrade checklist Tasks involved n migrating customized code in legacy models to the most
recent Microsoft Dynamics AX release.

Data upgrade checklist Tasks involved in upgrading data on the Microsoft Dynamics AX 2012 target
system.

Upgrade state transfer tool

In a source-to-target upgr ade, the most labor-intensive phase is data preprocessing. Assuming that you
follow the best practice of performing your upgrade first on a non -production system, you will invest
considerable time completing data preprocessing on a test source system. Theupgrade state transfer tool
allows you to capture that effort by transferring preprocessed data from a test system to your production
system. For more information, seeUsing the Preprocessing upgrade state transfer tool.

Row count validation after upgrade

The Compare data upgrade row counts task in the Data upgrade checklist checks the data integrity on
the Microsoft Dynamics AX 2012 target system following upgrade. Correctly correlated row counts among
the source, shadow, and target tables suggest, but do not confirm, that bulk copy and data upgrade
finished successfully. For more information, seeCompare data upgrade row counts.

Supported upgrade paths

You can upgrade to Microsoft Dynamics AX 2012 directly from either Microsoft Dynamics AX 4.0 or
Microsoft Dynamics AX 2009. If you have a version that is earlier than Microsoft Dynamics AX 4.0, you
must upgrade to Mic rosoft Dynamics AX 2009 before you can upgrade to Microsoft Dynamics AX 2012.

For information about supported system configurations, use the following links:
1 System requirements for Microsoft Dynamics AX 4.0
I Microsoft Dynamics AX 2009 System Requirements

Upgrading from a Microsoft Dynamics AX source system that uses an
Oracle database

You cannot use an Oracle database with Microsoft Dynamnics AX 2012. If you are upgrading from an
installation of Microsoft Dynamics AX that uses an Oracle database, you must first migrate your data to a
Microsoft SQL Server database, and then upgrade to Microsoft Dynamics AX 2012.
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Use the Oracle to Microsoft SQL Server Data Migration Assistant for Microsoft Dynamics AX tool to
migrate your data to a SQL Server database. You can download the tool and theOracle to Microsoft SQL
Server Data Migration Assistant for Microsoft Dynamics AX Installation Guidfom Customer Source

Hardware and software requirements

For up-to-date hardware and software requirements for Microsoft Dynamics AX, download the systems
requirements document.

Best practices for upgrade

This topic describes practices that will improve your upgrade experience and minimize the possibility of
problems along the way. We recommend reviewing and following these practices before starting your
upgrade.

Upgrade in a test environment first

Upgrade to Microsoft Dynamics AX 2012 in a test environment before you upgrade in your production
environment.

Confirm that both the source and target test systems are working correctly before you begin upgrade in
your production environment. For more information about testing, see Test the system after upgrade.

7 Tip:
Microsoft Dynamics AX 2012 allows you to preserve and reuse the preprocessed data that is created
on a test source system. Using this approach reduces preprocessing timeon your production source
system. For more information, see Using the Preprocessing upgrade state transfer tool.

Disk space and log size

Verify that you have the proper amount of space on your target system hard drive and in your database
transaction log.

Database server configuration

Ensure that Microsoft SQL Server is configued for the highest possible performance and throughput.
The upgrade process should take place on a dedicated database server. If there are other applications
running on the server, they will compete with the upgrade process for resources.

Review the performance benchmarks of the existing database server and determine if you need to add
more resources. This might include upgrading server components such as processor(s), memory, or
storage. After you upgrade or change server components, you should test the server for optimum
performance before you start the Microsoft Dynamics AX upgrade process.
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Before you upgrade

This section covers tasks that must be completed before you begin your upgrade to Microsoft Dynamics
AX 2012. The following topics are included.

i Clean up your data
1 Activate multisite functionality
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Clean up your data

Before upgrading to the latest version of Microsoft Dynamics AX, we recommend that you perfo rm
maintenance on your existing Microsoft Dynamics AX database. Cleaning up the database can reduce its
size, cut the time required for upgrade, and minimize the possibility of errors during data upgrade.

To help system administrators manage database cleanup, Microsoft provides the Intelligent Data
Management Framework (IDMF) for Microsoft Dynamics AX. The IDMF assesses the health of the
Microsoft Dynamics AX application, analyzes current usage patterns, and assists in reducing database size.
This utility can be used to optimize both Microsoft Dynamics AX 4.0 and Microsoft Dynamics AX 2009
databases.

Getting and using the Intelligent Data Management Framework
Obtain the IDMF and its accompanying documentation using the following links:

1 Intelligent Data Management Framework For Microsoft Dynamics AX (Installer download)

1 Intelligent Data Management Framework For Microsoft Dynamics AX: Installation Guide (PDF file)

91 Intelligent Data Management Framework For Microsoft Dynamics AX: Administration Guide (PDF
file)

4 Note:
IDMF is available only through CustomerSource and PartnerSource

Activate multisite functionality

When you upgrade to Microsoft Dynamics AX 2012, you must activate the multisite functionality for all
company accounts before you upload your XPO file. The method you use to activate multisite
functionality depends on the source system, and whether the Trade and Logistics licenses and
configuration keys are enabled.

This topic contains information ab out the following upgrade scenarios:

1 Activate multisite functionality when you upgrade from Microsoft Dynamics AX 2009 to Microsoft
Dynamics AX 2012.

1 Activate multisite functionality when you upgrade from Microsoft Dynamics AX 4.0 to Microsoft
Dynamics AX2012.

1 Trade and Logistics licenses after you upgrade.

Activate multisite functionality when you upgrade from Microsoft
Dynamics AX 2009 to Microsoft Dynamics AX 2012

When you upgrade from version Microsoft Dynamics AX 2009 to Microsoft Dynamics AX 2012, u® the
Multisite activation wizard  to activate multisite functionality for each account before you start the
upgrade process.

Microsoft Dynamics AX 2012 Upgrade Guide 11


https://mbs.microsoft.com/customersource/downloads/servicepacks/ax_idmf.htm
https://mbs.microsoft.com/downloads/customer/AX/ProductReleases/IDMF_Installation_Guide_V2.pdf
https://mbs.microsoft.com/downloads/customer/AX/ProductReleases/IDMF_Admin_Guide_V2.pdf

Microsoft Dynamics AX

0 Important:
If you activate the multisite functionality before you load the upgrade XPO file, you will
experience problems when you run the Multisite activation wizard

The wizard changes the following inventory dimension settings to support the use of the multisite
functionality:

1 The site dimension and warehouse dimension become active in all inventory dimension groups.

1 The site dimension becomes mandatory, and a site value must appear on all inventory
transactions.

1 A warehouse value must be entered on all issues and receipts. Blank issues and receipts are not
allowed for the warehouse dimension.

A Note:
To identify any transaction-related issues that will prevent the multisite functionality from being
activated, you may run the Multisite activation readiness report.

A Note:
To perform this task, the LogisticsAdvanced configuration key must be enabled. If the
configuration key is not e nabled, activation will occur in the same way as when you upgrade from
Microsoft Dynamics AX 4.0.

1. Click Administration > Reports > System > Multisite activation readiness to open the report.

2. Inthe Site field, select a site, or enter a site, to setas the default site to use when no warehouse is
associated with a transaction. If a default site is stored in the database for this company, the field may
be populated with the stored value, but you can override it.

3. Inthe Warehouse field, enter the name of a new warehouse to set as the default warehouse to use
when no warehouse is associated with a transaction. If a default warehouse is stored in the database
for this company, the field may be populated with the stored value, but you can override it.

A Note:
The warehouse name that you enter must be new: The warehouse name must not exist and
must never have existed. There cannot be any existing transactions that reference the
warehouse name that you enter here. If these conditions are not met, the program displays an
error message, and the report is not generated.

4. Select whether to generate the report directly or in batch.

5. Click OK.

For more information about how to prepare master data in Microsoft Dynamics AX 2009 for multisite
functionality, and how to use the Multisite activation wizard , see About sites and the multisite

functionality .

Activate multisite functionality when you upgrade from Microsoft
Dynamics AX 4.0 to Microsof t Dynamics AX 2012

When you upgrade from Microsoft Dynamics AX 4.0 to Microsoft Dynamics AX 2012, use theActivate
multisite item on the pre -upgrade checklist to activate the multisite functionality. During the upgrade,
the script assigns a default site for warehouses, work centers, and so on, and the multisite functionality is
activated in all companies. All transactions are associated with a site based on the warehouses and work
centers that the transactions are assigned to.

12 Microsoft Dynamics AX 2012 Upgrade Guide
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0 Important:
Before you upgrade, if you are using virtual companies you must make the following changes to
their configuration:

1 Make sure that the inventory dimensions table is not shared.
1 Make sure that tables that contain inventory dimension fields are not shared.

Dimension group settings and data inconsistencies can prevent multisite functionality from
becoming active. Under these circumstances, when you active the multisite functionality it can
cause changes in the calculated item cost.

If a production order spans multiple sites, the order must be closed before multisite is activated in
order to maintain accurate cost information. For example, on a purchase order line for 100 T-
shirts, 50 T-shirts are received in one Warehouse and 30 T shirts in another. If these warehouses
are on different sites, multisite cannot be activated until that purchase order line is closed. If you
do not close the purchase order line, the cost may be incorrect.

Trade and Logistics licenses after you upgrade

When you upgrade to Microsoft Dynamics AX 2012, and the Trade license and associated configuration
keys are enabled, the functionality associated with the Logistics license is also enabled.

Microsoft Dynamics AX 2012 Upgrade Guide 13
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Preprocess data on the source system

This section describes data upgrade preprocessing on the Microsoft DynamicsAX source system. Data
upgrade preprocessing is the most important new feature in the Microsoft Dynamics AX 2012 upgrade. By
preprocessing your data, you can prepare your Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009
system for upgrade with less downtime than in previous versions. The following sections are included.

Install upgrade framework files

Install optional upgrade XPO files

Start the Preprocessing upgrade checklist
Prepare for upgrade

Prepare application data for preprocessing
Preprocess data on the live system
Preprocess data in singleuser mode
Additional upgrade preprocessing tasks

= =4 =4 =4 4 -4 -4 -4
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Install upgrade framework files

The Microsoft Dynamics AX 2012 upgrade process requires manual installation of three files on your
source Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system. An XPO file provides the forms
and scripts that are required for data preprocessing, an ALD file provides user interface labels, and a CHM
file provides user Help. The sections below describe how to install these files from your Microsoft
Dynamics AX 2012 installation media.

Install and import the XPO upgrade fr amework file
The preprocessing XPO file installs an upgrade framework containing the following components:

1 ThePreprocessing upgrade checklist

1 The userinput forms opened by the items in the checklist

9 The preprocessing upgrade scripts

1 Changes to the upgrade cockpit for upgrade readiness, live preprocessing, live delta preprocessing,
and final preprocessing in single-user mode

You will import the preprocessing XPO into the USR layer on the Microsoft Dynamics AX source system.
You can see the current applicaion layer in the lower right of the Microsoft Dynamics AX client window.

A Note:
If the current application layer is not the USR layer, you must exit Microsoft Dynamics AX and
then create or modify the configuration by using the Microsoft Dynamics AX Config uration
Utility . In Microsoft Dynamics AX 4.0, the path isStart > Administrative Tools > Microsoft
Dynamics AX Configuration Utility . In Microsoft Dynamics AX 2009, the path isStart >
Administrative Tools > Microsoft Dynamics AX 2009 Configuration . Recorfigure the client so
that it opens in the USR layer.

Be sure to back up your application files (*.aod) and label files (*.ald) before you import the preprocessing
XPO. You will need these files for code upgrade on the Microsoft Dynamics AX 2012 target sysem.
To install the preprocessing XPO on the Microsoft Dynamics AX source system, do the following:

1. Open the Application Object Tree (AOT) from its icon on the toolbar.

2. (Optional.) It is advisable to make sure that the Application Object Directory (AOD) is synchronized
with the Microsoft Dynamics AX database schema before you begin to import of the XPO.
Synchronize them as follows:

1 Right-click Data Dictionary , and then click Synchronize .
Synchronization may take several minutes.

3. Click the import icon on the AOT menu bar.

4. Inthe Import dialog box, click Browse. The XPO is located in the DatabaseUpgradeXPO folder on

the installation media. The XPO file that you import depends on the Microsoft Dynamics AX source

system that you are upgrading from.

1 On a Microsoft Dynamics AX 4.0 source system, import UpgradeAX4.xpo.

1 On a Microsoft Dynamics AX 2009 source system, import UpgradeAX5.xpo.

In the Import dialog box, make sure that the option Import with ID values is cleared.

Click OK.

In the Import message box, clickYes to all when you are prompted to continue the import.

During synchronization, the Problems during synchronization message box may warn you that

tables will be dropped. You should be aware of what objects are being over-written so that you can

© N o O
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stop the process if necessary and merge your custom code with the XPO code for objects common to
them both. To allow an object to be overwritten, click Yes.

Microsoft Dynamics AX 2009 automatically performs multiple compilation passes to make sure that
validation is successful. For example, if a child object in the code is validated before its parent object, the
system will display a compilation error, but in a subsequent compilation pass, the parent-child object
relationship will be established and the error will no longer be displayed.

Microsoft Dynamics AX 4.0 does not automatically perform multiple compilation passes. If you import the
preprocessing XPO into Microsoft Dynamics AX 4.0, you may have to manually recompile the application
until no compilation errors are returned.

Install the ALD label file

The ALD file contains the labels that appear in the upgrade framework user interface. ThePreprocessing
upgrade checklist and associated forms will not be displayed properly without this f ile. To install the ALD
file, do the following:

1. Onyour installation media, navigate to the folder DatabaseUpgrade\ALD folder and locate the ALD
label file that you plan to use. Your choice will depend on the default language that you want to
install. For example, the file axUPGenus.ald provides labels in United States English for the upgrade
framework forms. Each language and language region that is supported by Microsoft Dynamics AX
has its own ALD file.

2. Copy axUPGenus.ald (or other selected ALD fle) to the label folder on your source system.

1 On atypical Microsoft Dynamics AX 4.0 system, copy the file to CtProgram Files (x86)Microsoft
Dynamics AX40\Application\Appl\Standard\.
1 On atypical Microsoft Dynamics AX 2009 system, copy the file to CtProgram Files Microsoft
Dynamics AX50\Application\Appl\ Standard\.
3. Restart the application object server.

Install the CHM file for user Help

The CHM file provides the documentation that opens when you click Help next to an item on the
Preprocessing upgr ade checklist . To install the CHM file, do the following:

1. Locate the file UpgradePreprocessing.chm in the DatabaseUpgradéCHM folder on your installation
media.
2. Copy the file to the appropriate directory on your Microsoft Dynamics AX source system.
1 On a Microsoft Dynamics AX 4.0 system, copy the file to CiProgram Files Microsoft Dynamics
AX\40\Client\Bin\Help\EN-US..
1 On a Microsoft Dynamics AX 2009 system, copy the file to CiProgram Filed Microsoft Dynamics
AX\50\Client\Bin\Help\EN-US..
7 Tip:
An additional CHM file, UpgradeScripts.chm, can also be found in the DatabaseUpgradéCHM
folder. This file provides documentation of the data upgrade preprocessing scripts that are
included with the upgrade framework.
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Install optional upgrade XPO files

Some optional Microsoft Dynamics AX features require additional XPO files to be installed prior to data
upgrade preprocessing. You should import these files only if you have the associated feature installed on
your source Microsoft Dynamics AX system, and you wantto migrate its data to Microsoft Dynamics AX
2012. The XPO files contain upgrade scripts and forms that are needed to prepare your source system
data for upgrade. These optional XPO files must be installedafter the upgrade framework XPO files have
been installed.

This topic also covers the batch processing XPO files, which are intended to roll back any customizations
that you have made to your batch processing class.

Feature XPO files

The optional XPO files, like the upgrade framework XPO files, are spefic to an earlier version of Microsoft
Dynamics AX. The correct version is signaled in the file name as follows:

f Microsoft Dynamics AX 4.0: O0AX406 or O0OAX4.06
T Microsoft Dynamics AX 2009: 0OAX56 or OAX5.06
All of these files are located on the installation media in the DatabaseUpgrade\XPO folder.

Feature Minimum XPO Components provided
Requirements

Lean manufacturing Lean manufacturing SharedProject_AX50PreUpgrade_Lean.xp¢
for Microsoft
Dynamics AX 2009

1 Additional tasks in
the Preprocessing
upgrade checklist
for lean
manufacturing

1 Userinput forms
that are opened by
the new checklist
tasks

1  Preprocessing
upgrade scripts for
lean manufacturing
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Feature Minimum XPO Components provided
Requirements

Process . Pr_ocess Industrigs for | PI_UpgradeAX4.xpo 1 An additional task

manufacturing Microsoft Dynamics PI_UpgradeAX5.xpo .

production and AX 4.0 SP2, or in the )

logistics Process Industies for Preprocessing
Microsoft Dynamics upgrade checklist
AX 2009 for process

manufacturing

1 A userinput form
that is opened by
the new checklist
task

1  Preprocessing
upgrade scripts for
process
manufacturing

Project Management | Professional Services | PrivateProject_ AX40Preprocessing_SI.xpo 1 For Microsoft

and Accounting add- | Automation for SharedProject AX50PreUpgrade_SI.xpo )
) . . Dynamics AX 4.0, a
in Microsoft Dynamics
AX 4.0 SP2. or modified upgrade
Professional Services script
/FAQLLJJtZTaUI\?Ih 200(‘; 1 For Microsoft
or Microso ;
D AX 2
Dynamics AX 2009 ynamies 009,
an additional
upgrade readiness
script

Batch processing XPO files

XPO files related to batch processing are included in the DatabaseUpgradéXPO folder, one for each
supported upgrade path:

1 PrivateProject_Ax40PreUpgradeFramework _Batch.xpo
1 PrivateProject_ Ax50PreUpgradeFramework _Batch.xpo

These XPO files will roll back any customizations that you have made to the batch processing class on
your Microsoft Dynamics AX source system. To keep data preprocessing downtime to a minimum, we
recommend that you import the appropriate XPO file for your system.

Start the Preprocessing upgrade checklist

The Preprocessing upgrade checklist guides you through the d ata preprocessing tasks on the Microsoft
Dynamics AX 4.0 or Microsoft Dynamics AX 2009 source system when you upgrade to Microsoft Dynamics
AX 2012.
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Avoid downtime with the source -to-target upgrade model

Because upgrade for Microsoft Dynamics AX 2012 uses source-to-target model, you can complete some
of the steps in the Preprocessing upgrade checklist concurrently with upgrade tasks that you complete
on the Microsoft Dynamics AX 2012 target system. For an overview of the upgrade process for Microsoft
Dynamics AX 2012 and more information about how data preprocessing tasks on the source system relate
to upgrade tasks on the target system, seeWhat's New: Upgrade.

Open the Preprocessing upgrade checklist

You install the framework for the Preprocessing upgrade checklist in the USR layer of the Microsoft
Dynamics AX source system by importing an XPO file. This operation installs all of the forms that are
required for completing the data preprocessing tasks and includes changes to the data upgrade cockpit
so that you can better manage the preprocessing scripts. For information about importing the upgrade
framework XPO file, seelnstall upgrade framework files.

After the XPO file has been imported, open the Preprocessing upgrade checklist as follows:

1. Click the Project icon on the toolbar and navigate to Projects> Shared .

2. ExpandShared and locate either Ax40PreUpgradeFramework or Ax50PreUpgradeFramework ,
depending on the version that you are upgrading from. Right -click it, and click Open.

3. Locate SysChecklist_preupgrade40 or SysCheckList_PreUpgrade50, depending on the version you
are upgrading from. Right-click it, and click Open to start the Preprocessing upgrade checklist .

Sections and tasks in the Preprocessing upgrade checklist

The Preprocessing upgrade checklist displays the required and optional tasks that are involved in data
upgrade preprocessing. The system records the completion of tasks and indicaes this status with a check
mark. The list of tasks is divided into four sections. When you open the Preprocessing upgrade checklist ,
these sections are collapsed. Expand each section to access the tasks. You can also collapse an expanded
section when you have completed the tasks within it.

The following table contains the sections and types of task you will complete during data upgrade
preprocessing on the Microsoft Dynamics AX source system.

Section Description

Prepare for upgrade The tasks in this ction test and prepare the source system for
upgrade. The tasks include creating the shadow and dictionary tables
where the upgrade framework will write the data that you prepare

for upgrade in the next section.

Prepare application data for preprocessing The tasks in this section prepare the Microsoft Dynamics AX source
system data for preprocessing while the source system remains in
production. Completing these tasks does not affect your production
system data.

When you click a task, a form opens and prompts you for
information. Because these tasks require knowledge of the
application data that you are preparing for upgrade, you will need
guidance from a business user in each of the application areas.

Preprocess data on live system These tasks run data peprocessing scripts while the source system is
still live for production. The prepared data is written into shadow
tables in preparation for bulk copy to the Microsoft Dynamics AX
2012 target system.
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Section Description

Preprocess data in single -user mode These tasks applyfinal preparation to the source data prior to bulk
copy. When you begin the tasks in this section, you start your system
downtime window. Your system will not be available for production
until you complete the data upgrade tasks on the Microsoft
Dynamics AX 2012 target system.

Each task in thePreprocessing upgrade checklist links to a Help topic that explains the task and
provides steps for completing it.

Prepare for upgrade

This section of the Preprocessing upgrade checklist contains tasks performed before data preprocessing
begins. The following sections are included.

 Check upgrade readiness
I View and fix upgrade readiness issues
9§ [Initialize preprocessing

Check upgrade readiness

You can check upgrade readiness before you begin upgrading data on the Microsoft Dynamics AX source
system. The readiness check produces a report that identifies issues that couldgotentially affect data
upgrade. Checks include identifying data that might cause failure of the data upgrade scripts and
identifying scenarios that will need extra planning before the upgrade. No changes to data are made
during the checks.

The upgrade readiness check is optional, but recommended. Running the readiness check will save time
and reduce the number of times you need to run the live or delta preprocessing scripts.

Run the upgrade readiness check

1. Inthe Preprocessing upgrade checklist , click Check upgrade readiness . TheUpgrade readiness
form opens to display a grid of readiness scripts waiting to be run. The grid provides a description of
each script, the method being invoked, the Microsoft Dynamics AX module that the script applies to,
and other information.

2. Click Run to begin running the scripts.

7 Tip:
By using the batch processing framework, you can set the number of batch server threads
available to the upgrade readiness scripts. Adding additional threads up to your processing
capacity will speed the completion of the scripts. For more information, see Batch processing
overview.

View readiness results and resolve issues

After the readiness scripts have run, a listof discovered issues is available. To view and resolve these
issues, open theUpgrade validation results  form in either of two ways:

1 Click the Readiness results button in the Upgrade readiness form.
9 Click the checklist taskView and fix upgrade readiness i ssues.
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For information about using this form, see View and fix upgrade readiness issues

Rerun the upgrade readiness scripts

After you fix any issues that were identified by the readiness scripts, you canrerun any or all of the failed
scripts. Each run of the upgrade readiness scripts results in a new report. You can refer to past readiness
reports by selecting one from the Run date menu in the Upgrade validation results  form.

To rerun a single script or multiple scripts when upgrading from Microsoft Dynamics AX 4.0, complete the
following procedures that apply:

1. Inthe Upgrade readiness form, select one or more scripts and click Rerun job .
2. Torerun all readiness scripts, clickReset status and then click Run.

To rerun a single script or multiple scripts when upgrading from Microsoft Dynamics AX 2009, complete
any of the following procedures that apply:

1 Inthe Upgrade readiness form, select one or more scripts and click Rerun script .
To rerun all failed scripts, click Rerun all failed scripts .
To rerun all readiness scripts, clickReset status and then click Run.

)l
)l
0 Important:

After you resolve issues in the scripts or in the data, you can rerun the readiness check as many
times as necessary until the scipts pass validation. Do not attempt an upgrade of your production
data until you have identified and resolved all of the upgrade issues flagged by the upgrade
readiness check.

View and fix upgrade readiness issues

The View and fix upgrade readiness issues task opens the Upgrade validation results form. Use the
Upgrade validation results form as a starting point to resolve issues that are discovered when you used
the Upgrade readiness form to run the upgrade readiness scripts.

M Note:
Resolving upgrade readiness issues helps prevent failure of the upgrade later in the upgrade
process.

Resolve readiness issues

The Upgrade validation results  form and the Upgrade validation details form provide the information
and tools that are needed to resolve readiness isstes.

1. Inthe Upgrade validation results form, in the Validation results grid, review the scripts that ran.
Each script has a status ofincomplete , Pass Error, or Advisory .

2. Select a job that has a status ofError or Advisory in the Validation results grid to view diagnostic
information in the Log grid.

3. For more information about a record that appears in the Log grid, click the Details button, if it is
available.

4. To fix an issue for a record, click theFix button and then enter any information th at is required in the
form that opens.
If the Fix button is not available, you must either resolve the issue manually or write an upgrade script
that resolves the issue. For information about scripts, see the white paper,How to Write Data
Upgrade Scripts for Microsoft Dynamics AX 2012
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Initialize preprocessing

The Initialize preprocessing task prepares the Microsoft Dynamics AX source system for data upgrade by
creating shadow and dictionary tables for all the data tables that are in the live production database. The
task also initializes the preprocessing scripts. The tables that are created by this step will hold the data
that is created during upgrade preprocessing. Most of the data in the shadow and dictionary tables is
created by the live and delta preprocessing scripts, though some records are created by each of the other
preprocessing tasks.

To initialize preprocessing and create the shadow and dictionary tables, complete the following steps:

1. Inthe Preprocessing upgrade checklist , expand Prepare for upgrade .
2. ClickInitialize preprocessing .

The upgrade framework creates the shadow and dictionary tables that are not created during importation
of the preprocessing XPO and, wten it finishes, opens aninfolog form that lists all the tables that were
created. This step also loads the preprocessing scripts into upgrade framework tables.

After you finish the Initialize preprocessing task, you can connect to the source database fram the
Microsoft Dynamics AX 2012 target system and begin preparing the target database for upgrade. This
allows you to save time by carrying out upgrade tasks concurrently on both systems.

Prepare application data for preprocessing

This section of the Preprocessing upgrade checklist contains tasks that involve manual changes to
application data in preparation for upgrade. The following topics are included.

System parameters

Set up number seqguence for upgrade
Company priority setup

Update country/region codes

Map country/region codes

Default country/region

Prepare financial dimension framework for upgrade
Map fixed asset calendars

Prepare currencies for upgrade

Inventory dimension group upgrade

Product upgrade (preprocessing)

Configure site structure

Map task groups to capabilities

Product Builder Route nodes upgrade

Units

Unit conversions

Fixed units

Unit texts

About purchase order upgrade

User relations upgrade - invalid company users
User relations upgrade missihng contact person
User relations upgrade duplicate user IDs

=A== _2_0_9_9_9_9_92_29_92_°2_29_9_°2_2_-92_-2°_-2._-2_-2-°_-2-
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§ Select which employee number to upgrade

System parameters

The system language is the defaultlanguage that is used by the application for text translations.
Use the System parameters form to specify a shared system language.

Set the system language

1. Click System parameters to open the System parameters form.

2. Select a system language in theSystem language field.

3. Inthe Chart of accounts delimiter field, select a symbol to use as the separator between financial
dimensions.

Set up number sequence for upgrade

In releases before Microsoft Dynamics AX 2012, the general ledger was always relatedo a single voucher,
regardless of the source document. Now that some subledger journal entries can be summarized when
they are transferred to the general ledger, a new numbering sequence is needed for the general journal
entries.

Use the Set up number s equence for upgrade form to set up the number sequence code for the legal
entities.

1. Click Set up number sequence for upgrade in the Preprocessing upgrade checklist to open the
Set up number sequence for upgrade form.

2. Inthe Company accounts field, select the set of legal entity accounts to upgrade the number
sequence for.

3. Click Set up number sequence to open the Set up number sequence form, where you can select
the number sequence code to use for the general journals.

4. To use the same number seqience code for all sets of legal entity accounts, click Apply to remaining
companies . Otherwise, repeat steps 2 and 3 until you have selected a number sequence code for all
sets of legal entity accounts.

5. Click Set to ready for upgrade to select this checklist item as ready for upgrade.

Company priority setup
When you merge the data from more than one company, the priority of the companies determines which
company's values take priority for the data.

Use the Company priority setup form to define the prio rity of companies.

A Note:
You must set up the company priority only if you upgrade items from more than one company.

Company priority affects product numbers and item dimension values

The company priority affects the following data when items are mapped t o products:

1 The sequence of product numbers
I The names and descriptions for sizes, colors, and configurations
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Company priority and the sequence of product numbers

If the items that you map to a product have identical numbers but come from different companie s, the
sequence of product numbers is determined by the company priority. For more information, see the
description of the 1:1 mapping method in Product upgrade (preprocessing).

Company priority and the na mes and descriptions of item dimensions

If the items that you map to a product have identical item numbers but come from different companies,

the active item dimensions of these items may have different names and descriptions. When several items
are mapped to one product, the names and descriptions of the item dimensions are consolidated. The
names and descriptions from the company that has the highest priority are used.

Example

1 Three identical items are mapped to one product. The items come from three dif ferent companies, C1,
C2, and C3.

9 The priority of C1 is 1, the priority of C2 is 2, and the priority of C3 is 3.

1 The item has one active dimension, Color. However, the name of the dimension is not the same in the
three companies.

)l

The following table shows this setup.

Company | ltem Item dimension Item dimension hame
C1l INV-1000 | Color Red

Cc2 INV-1000 | Color _Red

C3 INV-1000 | Color "Red"

The items are mapped to one product, PROD1000. The name of the Color dimension is consolidated to
Red, because this nameis used in C1, the company that has the highest priority.

Company priority and product translations

When items are mapped to products, product translations are derived in the same way as dimension
names and descriptions. When several items are mapped to ae product, if more than one translation into
a particular language exists for the items, the translations are consolidated. The translation from the
company that has the highest priority is used.

The initial company takes priority

When a mapping is completed, there is always a oneto-one relationship between items and products.
Furthermore, an item is always initiated from one comp.
where the item was first created. Therefore, if you map items to existing products by aligning the product

numbers in the Product upgrade form, the initial company always has the highest priority, regardless of

how company priority is set up.

Example

In the previous example, product PROD 1000 inherited the dimension name from item IN V-1000 in
company C1, because C1 had the highest company priority. You how want to map an additional item,
INV-A100, to PROD1000. Item INV-A100 comes from another company, CA, which has a higher priority
than C1. However, C1 takes precedence when propergés such as the dimension name are copied to
PROD 1000, because C1 is assigned as the initial company of PROL1000. Therefore, when properties are
copied, the order of priority is C1, CA, C2, and C3.

The following table shows this setup.
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Company priority Iltem Initial mapping Additional mapping Initial company
CA INV-A100 PROD1 C1
C1 INV-1000 | PROD1 PROD1 C1
C2 INV-1000 | PROD1 PROD1 C1
C3 INV-1000 | PROD1 PROD1 C1
7 Tip:

You can view the initial company of a product in the Company field on the Mapping tab of the
Product preview form.

Update country/region codes

A list of default country/region codes is delivered in Microsoft Dynamics AX 2012. This list also includes 18
default address formats and component information for the countries/regions, such as state/province,
county, city, district, and ZIP/postal code.

If you want to change the default address format that is assigned to a country/region code, you can select
another address format in the Address format column. For example, the country/region for Antarctica
has a default address format of 0001. This means that the address components are displayed in the
following way:

Street name
City_State_ZIP/postal code
Country/region

You might select to change the default address format to 0013. After you make the change, the address
components are displayed in the following way:

Street name
City, ZIP/postal code
Country/region

Use this form to view default country/region codes and the corresponding address formats. You can also
add new country/region codes and select corresponding address formats for them. The country/region
codes and address formats will be used for address records in Microsoft Dynamics AX 2012.

@ Note:

In the Map country/region codes form, you will map the countries/regions from Microsoft
Dynamics AX 4.0 or Microsoft Dynamics AX 2009 to the countries/regions that are displayed in
the form. You cannot map more than one country/region code from the same company to a
country/region code listed in the Country/region codes form. You must manually create a
unique country/region code for all countries/regions in the same company before the upgrade.

1. Inthe Preprocessing upgrade checklist , click Update country/region codes to open the
Country/region codes form.
2. Review the list and verify the short name, long name, and address format for the countries/regions.
1 You can modify the short name and long name by editing the field. The countries/regions that
you add to this list will appear in Microsoft Dynamics AX 2012 in the user language. Any other
translations must be entered manually in Microsoft Dynamics AX 2012 after upgrade is
completed.

Microsoft Dynamics AX 2012 Upgrade Guide 25



Microsoft Dynamics AX

1 You can select a different address format in the Address format field. This list includes default
address formats and any address formats from Microsoft Dynamics AX 4.0 or Microsoft Dynamics
AX 2009.
3. To add a country/region code that was used in Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX
2009 but does not appear in the list, press CTRL+N and do the following:
a. Inthe Country/region code field, enter the country/region code that you want to add.
b. Enter the short name and long name for the country/region, and then in the Address format
field, select the address format that corresponds to the selected country/region.
4. Click Set to ready for upgrade

Map country/region codes

In Microsoft Dynamics AX 4.0 and Microsoft Dynamics AX 2009, more than one country/region code
could be assigned to a country/region. Only one country/region code per company from Microsoft
Dynamics AX 4.0 or Microsoft Dynamics AX 209 can be mapped to a country/region code in Microsoft
Dynamics AX 2012. Before you upgrade to Microsoft Dynamics AX 2012, all country/region codes in your
current version of Microsoft Dynamics AX must be mapped to a country/region code in Microsoft
Dynamics AX 2012.

For example, in Microsoft Dynamics AX 4.0, you may have assigned the country/region code GBR to both
Great Britain and the United Kingdom. Before you can upgrade to Microsoft Dynamics AX 2012, you must
reassign the GBR code to one of thosecountries/regions and assign a new unique country/region code to
the other country/region.

Use this form to map the country/region codes in all companies in Microsoft Dynamics AX 4.0 or
Microsoft Dynamics AX 2009 to the country/region codes in Microsoft D ynamics AX 2012. All
country/region codes must be mapped from the earlier version to Microsoft Dynamics AX 2012.

@ Warning:
If your Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 application contains
customized code that affects the handling of cou ntry/region data, you might encounter errors
during data preprocessing. If you encounter these errors, you will need to write an upgrade
preprocessing script to correctly map your existing data to the Microsoft Dynamics AX 2012
schema. For more information, see the white paper How to Write Data Upgrade Scripts for
Microsoft Dynamics AX 2012

1. Inthe Preprocessing upgrade checklist , click Map country/region codes to open the
Country/r egion code mapping form.

2. For each country/region in the grid, in the Mapped country/region  column, use the menu to select
the Microsoft Dynamics AX 2012 country/region code that corresponds to the country/region code
from your earlier version of Microso ft Dynamics AX. The country/region code from your earlier version
is displayed in the Country/region code column.

3. After you map all the country/region codes from the earlier version of Microsoft Dynamics AX to the
country/region codes in Microsoft Dynam ics AX 2012, clickSet to ready for upgrade

Default country/region

In Microsoft Dynamics AX 2012, all postal addresses must have a corresponding country/region. Use this
form to validate and update the default country/region code for each company in your organization.
When you upgrade from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009, the country/region
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that you select here for a company becomes the country/region for address records in that company that
do not have a specified country/region. After you have completed the Prepare application data for
preprocessing section of the Preprocessing upgrade checklist , you can use the Addresses with no
country/region form to change the country/region for an address record.

1. Inthe Preprocessing upgra de checklist, click Default country/region  to open the Default
country/region for addresses  form.

2. Review the country/region that is assigned to the companies in the list. This is the country/region
code that will be assigned to any address that does not already have a country/region code assigned.

3. To change the country/region for a company, select a country/region in the Default country/region
code field.

4. After you have verified the country/region defaults for each company, click the Set to ready for
upgrade button.

Prepare financial dimension framework for upgrade

A main account category is a classifier of a main account. A financial dimension is a financial data classifier
that is created from the parties, locations, products, and activities in an organization, and that is used for
management reporting.

In Microsoft Dynamics AX 2009, you could create ledger account categories and financial dimensions for
each company. In Microsoft Dynamics AX 2012, the main account categories and financial dimesions that
you create are shared, and can be used by any of the legal entities that are set up in Microsoft Dynamics
AX.

A Note:
Dimension focuses have been renamed to financial dimension sets and are shared by the legal
entities that are set up in the Legal entities form. Therefore, the financial dimension sets can be
used by any of those legal entities. Financial dimension sets in Microsoft Dynamics AX 2012 differ
from the dimension sets in previous releases.

Use the Prepare financial dimension framework  for upgrade form to select the main account
categories and financial dimension sets that will be shared by the legal entities.

1. Click Prepare financial dimension framework for upgrade to open the Prepare financial
dimension framework for upgrade  form.

2. Inthe Company accounts field in the Ledger account categories field group, select the company
account that contains the main account categories that will be available as shared main account
categories.

A Note:
This field is available only if you are upgrading from Microsoft Dynamics AX 2009.

3. Inthe Generate shared dimension focuses field, select how to create financial dimension sets:

1 For each company account 4 All the financial dimension sets that currently are set up for the
accounts in each companywill be available as shared financial dimension sets.

1 Specific company account 9 Only the financial dimension sets for the accounts in the company
that you select in the Company accounts field in the Dimension focuses field group will be
available as sharda financial dimension sets.

4. If you selected Specific company account , select the company account that contains the financial

dimension sets that will be shared. Otherwise, continue to step 5.
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5. Optional: Click Ledger account categories upgrade validati on to display the ledger account
categories that have upgrade errors.

A Note:
This button is available only if you are upgrading from Microsoft Dynamics AX 2009.

6. Optional: Click Dimension focus upgrade validation to display the shared financial dimensions sets
and the upgrade error status of each financial dimension set.
7. Click Set to ready for upgrade to select this checklist item as ready for upgrade.

@& Warning:

Do not change financial dimension names after you start the Preprocessing upgrade checklis t,
and before the update is completed.

Map fixed asset calendars

When you upgrade to Microsoft Dynamics AX 2012, you must use the Upgrade fixed asset calendars
form to upgrade existing fixed asset calendars to fiscal calendars that can be shared by multipk legal
entities.

You can then use the Ledger form in Microsoft Dynamics AX 2012 to select a fiscal calendar.

@ Note:
When you upgrade fixed asset calendars, each new fiscal calendar must have a unique name.

1. Review the list of companies that use fixed asset calendars, and then review the names of the fixed
asset calendars in theCalendar name column.
9 If all the calendar names in the Calendar name column are unique, you do not need to make any
changes.
1 If two or more calendars have the same name in the Calendar name column, a new name must
be assigned so that each calendar name is unique. For each duplicate calendar name, a new name
is suggested in the New name column. You can change these suggested names.
2. When you are finished, click Set to ready for upgrade to upgrade the fixed asset calendars to fiscal
calendars.

Example

Both Legal entity A and Legal entity B have fixed asset calendars named RBAO1 (Reducing Balance Asset
1). Your task is to upgrade the fixed asset calendars to fiscal calendars. Inite New name column, you
change the names of the calendars to RBAO1A and RBAQ1B. After you upgrade the calendars, the
calendars are shared and can be used by any legal entity or by multiple legal entities.

Prepare currencies for upgrade

In releases previais to Microsoft Dynamics AX 2012, you could set up currencies for each company. In
Microsoft Dynamics AX 2012, the currencies that you set up are shared by the legal entities that are set up
in the Legal entities form, so the currencies can be used by anyof those legal entities.

Use the Prepare currencies for upgrade form to select the currencies, a triangulation currency, and the
exchange rates that will be shared by the legal entities.

1. Click Prepare currencies for upgrade to open the Prepare currenci es for upgrade form.
2. Inthe Generate shared currencies field, select which currencies will be available as shared currencies:
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1 For each company 0 All the currencies that currently are set up in each company will be available
as shared currencies.

1 Specific company account 06 Only the currencies for the company that you select in the
Company accounts field in the Currencies field group will be available as shared currencies.

3. If you selected Specific company account , select the company account that contains the currencies
that will be shared.

4. Inthe Company accounts field in the Triangulation currency field group, select the company
account that contains the triangulation currency to upgrade. This triangulation currency will represent
the euro currency.

5. Inthe Generate shared exchange rates field, select which exchange rates will be available as shared
exchange rates:

1 For each company 0 All the exchange rates that currently are set up in each company will be
available as shared exchange rates.

1 Specific company account 6 Only the exchange rates for the company that you select in the
Company accounts field in the Generate shared exchange rates field group will be available as
shared exchange rates.

6. If you selected Specific company account , select the mmpany account that contains the exchange
rates that will be shared.

7. Optional: Click Currency code upgrade validation to display the shared currency codes and the
upgrade error status of each code.

8. Click Set to ready for upgrade to select this checkist item as ready for upgrade.

Inventory dimension group upgrade

Use the Preprocess inventory dimension groups  form to define how company -specific inventory
dimension groups are consolidated into a set of inventory dimension groups that are shared between
companies.

The inventory dimension grouping is new

In Microsoft Dynamics AX 2012, the inventory dimension groups are split into three groups: product,
storage, and tracking. The groups contain the following dimensions.

Group Dimensions

Product Color, Size Configuration

Storage Site, Warehouse, Location, Pallet ID

Tracking | Batch number, Serial number

The Color, Size, and Configuration dimensions, which were previously called item dimensions, are now
found in the product dimension group. Furthermor e, the storage dimensions are now divided between a
storage dimension group and a tracking dimension group.

Each inventory dimension group that already exists must be mapped to one of the new product, storage,
or tracking dimension groups.

A Note:
If an inventory dimension group has no active item dimensions, the mapping methods do not
create a product dimension group. A product dimension group cannot be created if there are no
active dimensions.
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Map preexisting company -specific inventory dimension group s to the new dimension groups

When you start preprocessing inventory dimension groups, the Preprocess inventory dimension groups
form contains a list of all preexisting inventory dimension groups from all companies. You must map the
company-specific inventory groups to the new product, storage, and tracking dimension groups.

1. ClickInventory dimension group upgrade  to open the Preprocess inventory dimension groups
form.

2. Click Dimension group mapping , and then select a method of mapping. The following options are
available:

1 Map dimension groups 1:1 3 For each preexisting inventory dimension group, create three
dimension groups: a product dimension group, a storage dimension group, and a tracking
dimension group. The active dimension in each new dimension group corresponds to one type of
active dimensions in the original, company-specific inventory dimension group. The names of the
new dimension groups consist of consecutive numbers prefixed by PDG_, SDG_, or TDG _.

A Note:
You can change this naming convention in the Map dimension groups 1:1 form.

1 Map dimension groups ID 8 For each preexisting inventory dimension group, create product,
storage, and tracking dimension groups, just as when you use the Map dimension groups 1:1
method. The difference between this method and the 1:1 mapping method is the naming
convention. When you use this method, the names of the new dimension groups are copied from
the original, company-specific inventory dimension groups.

A Note:
Consolidating inventory dimension groups fro m different companies that use identical
naming conventions for dimension groups can cause validation errors. For example, if
both company 1 and company 2 have an inventory dimension group that is named
DimGroup1, the identical names can cause a validationerror. The active dimensions and
the setup of the active dimensions must be identical. Otherwise, the upgrade
consolidation is not successful.

1 Map dimension groups by setup & Map dimension groups according to the setup of the active
dimensions and settings of the inventory dimension groups. For more information, see the next
section.

3. Click Dimension groups to view and change the names and descriptions of the new dimension
groups.

a. To change the name of a new dimension group, you must first change the name of the original
inventory dimension group in the Preprocess product dimension groups , Preprocess storage
dimension groups , or Preprocess tracking dimension groups  form.

b. Then select the new name for the product, storage, and tracking dimension groups in the
Preprocess inventory dimension groups  form.

4. Click Validation report to check for validation errors before you set the dimension groups to ready
for upgrade.
5. After you resolve all validation errors, click Set to ready for upgrade

Mappin g according to the setup of the inventory dimension groups

You can map the new, shared product, storage, and tracking dimension groups according to the active
item and storage dimension setup in the original inventory dimension groups. For each preexisting
inventory dimension group, the program proposes a product dimension group, a storage dimension
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group, and a tracking dimension group. When new groups are created, the configurations in all the
existing inventory groups are considered. The new product, storage, and tracking groups are based on
information that is merged from all the existing inventory groups.

When you map inventory dimension groups by setup, the program may propose the same product,
storage, or tracking dimension group for more than one i nventory dimension group. This is because the
existing inventory dimension groups have the same setup of active product, storage or tracking
dimensions.

Example: Map inventory dimension groups by setup
In the following example, three company-specific inventory dimension groups, InvGroup1, InvGroup2, and
InvGroup3, are consolidated into product, storage, and tracking dimension groups.
@ Tip:
The three inventory groups can come from three different companies, or they can all come from
the same company.

The following table shows the setup of the active dimensions in the three inventory dimension groups.

InvGroupl InvGroup2 InvGroup3
Color

Size Size

Configuration Configuration

Site Site Site

Warehouse Warehouse Warehouse

Serial number Serial number
Batch number | Batch number

The following table shows the dimension groups that Microsoft Dynamics AX proposes, based on the
setup of the preexisting company-specific inventory dimension groups.

1 For the item dimensions, Color, Size, and Configuration , the setup of active dimensions in InvGroup2
differs from the setup in InvGroupl and InvGroup3. Therefore, two product dimension groups are
created.

1 For the storage dimensions, Site and Warehouse, the setup of active dimensions is identical in
InvGroupl, InvGroup2, and InvGroup3. Therefore, one storage dimension group is created.

1 For the Batch number and Serial number dimensions, the setup of active dimensions is different in
InvGroupl, InvGroup2, and InvGroup3. Therefore, three tracking dimension groups arecreated.

Product dimension groups

Storage dimension groups

Tracking dimension groups

PDG_1

SDG_1

TDG_1

- Size - Site - Serial number

- Configuration - Warehouse - Batch number

PDG_2 TDG_2

- Color - Serial number
TDG_3

- Batch number
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Product upgrade (preprocessing)

In Microsoft Dynamics AX 2012, there are new processes for handling items. A new structure requires any
item that is configured in a company to be based on a product definition. Therefore, any item that is
handled in inventory, or during the purchase or sales process, must be associated with a product
definition. Product definitions reside at the shared level.

You use the Product upgrade form to define how existing, company -specific items are mapped to
products.

A Note:
Before you can start mapping items to products, you must set the company's priority and
complete the preprocessing of inventory dimensions.

New product concepts

To understand how items are mapped to products, you must be familiar with the following new concepts
that are introduced in Microsoft Dynamics AX:

1 Product master d A standard or functional representation of a product that is the basis for configuring
product variants.

1 Product variant 8 A configuration of a product master.

9 Distinct product 8 A uniquely identifiable product.

Items are upgraded to product masters and distinct products

Existing items that have active item dimensions are created as product masters. Items that do not have
active item dimensions are created as distinct products.

Combinations of item dimensions are created as variants

When you map items to products, combinations of item dimensions are created as product variants.
Therefore, product variants are created for product masters, and product masters are based on items that
have active item dimensions.

# Tips:
In the Product upgrade form, click View > All item dimension combinations  to view the
combinations of item dimensions for items that have active item dimensions.

In the Product preview form, click Variants to view product variants.

The mapping process

There are two mapping methods. The method that you choose determines the level of manual work that
you must do to map items. Your choice depends on factors such as the number of items and the number
of different companies for which items must be merged. For example, if you upgrade two lists of items,
and each list contains identical items, you may want to map by item number. If you map by item number,
items that have identical item numbers are merged. You can complete a cleanup of the data after the
mapping instead of after the upgrade. However, when you map by item number instead of using the 1:1
method, there is a higher risk of validation errors. There is also a greater likelihood that you must perform
manual work later.
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Synchronize

When you synchronize items, you synchronize the data in the upgrade environment with the existing data
in the system.

A Note:
The first time that you open the Product upgrade form, the fields are empty. The fields are not
populated until you synchronize items.

Synchronize items

1. Click Product upgrade to open the Product upgrade form.
2. Click Synchronize items to synchronize the items in the upgrade environment.

[ Notes:
You cannot continue the mapping process until the synchronization is completed.

If item data is changed during the upgrade process, you can synchronize items at any time to
make sure that the upgrade environment includes the most recent data.

Map items
You can choose between the following two mapping methods:

1 Map allitems 1:1 o Each item is mapped o a unique product of the Product master or Distinct
product subtype. The item number is replicated in the new product number. The name and search
name of the product are identical to the name and search name of the item.

1 Map all items by item number 8 All items that have identical item numbers are mapped to the same
product. For example, if you map items from two different companies, items that have the same item
number can be mapped to one product.

@ Note:
If two items that have identical item numbers hav e different names or different setups for
their item dimensions, for example, you receive a validation error. The solution depends on
the problem. If the names of the two items are different, you can change the text in the
Product name fields in the Product preview form. If the dimensions are different, you must
change the original data in the system. However, you may not be able to make the changes if
transactions exist in the system.

Map items 1:1

1. Inthe Product upgrade form, click Product mapping , and then selectMap all items 1:1 .
2. Inthe Map all items 1:1 form, enter a prefix in the Product number prefix field, and then enter
an initial number in the Initial number field.

II‘[ Note:

The numbering convention that you define in the Product number prefix and Initial number
fields is only applied if you map items that have identical numbers but come from different
companies. For these items, the product numbers are replaced with numbers based on this
convention.

The sequence of product numbers is based on the company's priority. To view or change the priority
of companies, click View > Company priority setup
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Example

Three items from three different companies have the item number XL-1000. For the numbering
convention, the product number prefix is PXL, and the initial number is 99.

The three item numbers come from three companies, C1, C2, and C3. The priority of C1 is 1, the
priority of C2 is 2, and the priority of C3 is 3.

The following product numbers are generated:

1 Item XL-1000 from company C1 & Product number: XL-1000

1 Item XL-1000 from company C2 & Product number: PXL99

Item XL-1000 from company C3 & Product number: PXL100

Map items by number

1. Inthe Product upgrade form, click Product mapping , and then selectMap all items by item
number .
2. Click OK to continue.

Approve the mapping

Product mappings must be approved before you can set the items to ready for upgrade. You can approve
all mappings, or reverse the approval of all mappings, from either the Product upgrade form or the
Product preview form. You can approve or reverse the approval of selected items only from the Product
preview form.

Approve or reverse all mappings from Product upgrade

1. Inthe Product upgrade form, click Product mapping approval
2. SelectApprove all mappings to approve all mappings. Select Reverse all mapping approvals to
reverse the approval of all mappings.

Approve or reverse all or selected mappings from Product preview

1. Inthe Product upgrade form, click View > Product preview to open the Product preview form.
2. Click Product mapping approval and select one of the following submenu commands:

1 SelectApprove all mappings to approve all mappings.
1 SelectReverse all mapping approvals to reverse the approval of all mappings.

1 SelectApprove selected mappings to approve mappings of the products that you have selected
in the Product preview form.

1 SelectReverse selected mapping approvals to reverse the approval of mappings for the
products that you have selected in the Product preview form.

Clear all product numbers

1 Inthe Product upgrade form, click Clear all product numbers to remove all product numbers
from a previous mapping.

Validate mappings

After you map items and approve the mappings, you can request a validation report. The validation report
shows the validation errors that are caused by incondstencies or data violations, such as when two items
that have identical names are mapped to the same product. If you mapped all items by item number, you
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may have to repeat the mapping process and the validation several times to resolve all of the validation
errors. You must repeat the mapping process and the validation until all errors are resolved.

A Note:
You cannot complete the upgrade until all validation errors are resolved. In addition to validation
errors, you may receive validation warnings. Validdion warnings are just warnings about
inconsistent data. The upgrade can be completed if there are validation warnings.

Validate all product mappings

1. Inthe Product upgrade form, click View > All validation results
2. Inthe Product validation form, click Validate all to update the view.

A Note:
You must click Validate all to update this form, even if you are opening the form for first time, or
if you previously validated the mappings.

Set to ready for upgrade

1 Inthe Product upgrade form, click Set to ready fo r upgrade to indicate that the products are
ready to be upgraded.

@ Note:
You must approve all product mappings before you set products to ready for upgrade. If
validation errors exist, you must resolve the errors before you can continue.

Troubleshoot produ ct variants with no association to a product master

On rare occasions, the preexisting data set can include item dimension combinations where one or more
of the corresponding item dimensions are inactive on the associated dimension group.

If this applies to your data set, we recommend that before you start to preprocess your data, you consider
how you want to handle these item dimension combinations.

In the upgrade process, all item dimension combinations are created as product variants. Product variants
depend on an association with a product master. If the potential product masters for the product variants
are based on items with inactive item dimensions, these items are mapped to distinct products rather

than to product masters. Product variants that lack an association with a product master prevent the data
from being properly upgraded.

To resolve this issue we recommend the following:

1 If possible, on the dimension groups, activate any item dimensions that are associated with item
dimension combination s.

1 If you cannot activate the dimensions, you can try to delete the item dimension combinations. Before
you delete, make sure that you back up your data.

Product preview

Use the Product preview form to view products, and to perform tasks on all products or selected
products. From this form, you can see how items are mapped to products of the Distinct product or
Product master subtype. You can also lock products, approve the mapping of products, and view product
details.
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Tip:

Some tasks, such as productmapping and product approval, can be completed in both the
Product upgrade form and the Product preview form. However, the two forms are not identical.
For example, the perspective in the forms is different. In the Product preview form, you view data
from the product's perspective. However, in the Product upgrade form, you view data from the
item's perspective. In addition, you can use the Product preview form to approve the mapping of
selected products. However, you approve product mappings from the Product upgrade form, the
approval applies to all items in the form.

View mappings and perform tasks on products

1.
2,

In the Product upgrade form, click View > Product preview to open the Product preview form.

Click the buttons to complete the following tasks:

1 Product mapping & Map all items, either by item number or by using the 1:1 method.

1 Product locking & Lock all products or selected products. Locked products are disregarded
during the mapping process. When you consider the mapping of a set of products final, yo u can
lock the products. The locked products are not affected if you later repeat the mapping process.

1 Product mapping approval : 0 Approve or reverse the approval of the mappings for all items or
selected items.

1 Validation 6 Validate all mappings or selected mappings.

7 Tip:
You can validate mappings at any time. When you validate a mapping, you receive a list
of validation errors and guidelines to help you resolve the errors.

1 Variants 6 View the product variants that were created for products of the Pr oduct master
subtype.
7 Tip:
The variants of a product correspond to the combinations of item dimensions for an item.
1 Configurations , Sizes, and Colors 0 View the setups for configuration, size, and color that are

inherited from the items.
1 Translations 0 View any text translations in different languages that were set up for the items.

Configure site structure

This topic explains how to define a structure for your sites, warehouses, and resource groups. Additionally,
you can specify the default site, warehouse, and the fallback warehouse to assign to transactions for which
this information is not available and cannot be deduced.

To configure the site structure

1.

w
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In the Configure site structure form, in the Filter by company field, select the company account for
which you want to define a site structure.

In the Site field, enter a unique identifier for the site.

In the Name field, enter the name of the site.

To assign a warehouse or resource to this site, click thewarehouses or Work center groups tab, and
then select the site in the Site field.

To specify the default site, warehouse, and fallback warehouse for this site, click theDefaults tab and
then select the site in the Default site , Default warehouse , or Fallback warehouse field.

Microsoft Dynamics AX 2012 Upgrade Guide



Microsoft Dynamics AX

Map task g roups to capabilities

Use this item on the preprocessing checklist to specify the capability that you must have in order to
convert task groups during the upgrade process. Task groups are not available in the target system.

Update task groups to capabiliti es

1. On the Preprocessing upgrade checklist , click Prepare application data for preprocessing > Task
group upgrade

2. Select a task group, and then click theMap task groups button and choose one of the following
conversion methods:

1 To map a task group conversion manually, select the task group and then enter a unique
identifier in the Capability field for each task group.

1 To automate the mapping and use the task group ID as the identifier for the capability, click the
Map task groups button and select Map task groups by task group ID across all company
accounts.

1 To automate the mapping using a 1:1 relationship between task groups and capabilities, click the
Map task groups button and select Map task groups 1:1 .

4 Note:
To delete existing mapping information , click the Map task groups button and select Clear
mapping of all task groups

Product Builder Route nodes upgrade

This topic describes how to map modeling variables assigned to product models and nodes in the
modeling tree to fixed values during the upgr ade process. The target system does not support modeling
variables. Therefore, existing modeling variables must be mapped to fixed values. The fields that are
available on the right side of the form can vary, depending on the modeling variables that are al located
for each product model.

Example

If a modeling variable is allocated for a resource in a product model, the Resource (Variable) field shows
the modeling variable. You must then select the fixed resource that you want to map the variable to in the
Resource field.

To map route variables for upgrade

1. Click Prepare application data for preprocessing > Product builder route nodes upgrade
2. Select a product model in the grid on the left side of the form. Depending on the modeling variables
that require mapping, do one of the foll owing in the available fields.

1 Inthe Resource field, select the fixed resource to which you want to map the modeling variable
shown in the Resource (Variable) field.
In the Load field, enter a number for the load that you w ant to map the modeling variable to.
1 Inthe Qty. of Resources field, enter a number for the quantity of resources that you want to map
the modeling variable to.
1 Inthe Job Requirement field, enter a number for the job requirement that you wantto map the
modeling variable to.
3. To mark this item on the preprocessing checklist as completed, and continue to the next item on the
preprocessing checkilist, click the Set to ready for upgrade button.

=
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Units

A unit of measure is a standard base or a derived division of quantity that is used for measurement or
exchange. For example, when you enter an order in Microsoft Dynamics AX, you specify both a quantity
and the unit of measure that the quantity represents.

Use the Preprocess units form to define how existi ng company-specific units of measure are mapped to
shared units of measure.

A Note:
You must set a system language before you can start this task.

Shared units of measure replace company -specific units of measure

Shared units of measure replace the companyspecific units of measure that are used in previous versions
of Microsoft Dynamics AX. You must map each companyspecific unit of measure that exists to a unit of
measure that is shared across companies.

@ Note:
You can change a shared unit of measure so hat it differs from the company -specific unit of
measure in the number of decimal places or in the description. The existing data in the system is
updated so that it reflects the changes.

Map company -specific units of measure to shared units of measure

When you start preprocessing units of measure, the Preprocess units form lists all units of measure from
all existing companies. When you map units of measure from different companies to one set of shared
units of measure, you must align information such as the number of decimal places. This information must
be aligned for each unit of measure.

1. ClickUnits to open the Preprocess units form.
2. Inthe Unit (shared) field, select the symbol that represents the shared unit of measure. Repeat this
step for each line.
7 Tip:
Click Automatic assignment to automatically assign each company-specific unit of measure
to a new shared unit of measure. When you click Automatic assignment , the value of the
Unit field is copied to the Unit (shared) field on all lines where the Unit (shared) field is
blank. However, you can manually change the value of theUnit (shared) field.
7 Tip:
We recommend that you use the international symbols for units of measure. For more
information, see General Tables of Units of Measurements

3. Confirm that the values of the Description and Decimals fields are the same for every company.
To consolidate a unit of measure from two companies, you select the same unit symbal in the Unit
(shared) field on each line. The values of theDescription and Decimals fields may be different on
each line. You must align the values of these fields for each shared unit of measure. When the values
of these fields are identical, the systemcan identify the lines that must be merged during the
upgrade.

A Note:
If units of measure from different companies have identical unit symbols, but the values of
the Decimals, System of units , and Description fields are different, the mapping cannot be
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completed. In the Preprocess units form, you can use one of the following methods to
resolve the issue:

1 Change the values of the Decimals, System of units , and Description fields, so that they are
the same for all units that have the same symbol.

1 Change the values of the Unit (shared) fields, so that they are different for the units that
have different properties.

The solution that you choose depends on the company setup. If the properties of the units of
measure differ by mistake, you can align the values ofthe fields for the properties. If the
properties must remain different, you must change one of the unit symbols.

7 Tip:
To filter the contents of a column, select a field, and then click Filter By Selection on the

toolbar. For example, to identify all lines that use the unit symbol kg, select the Unit (shared)
field that has this value.

4. Inthe Unit class field, select a classification for the unit of measure.
g Tip:
The unit class represents a logical grouping of units of measure, such as area or quanty. The

unit classes specify base units and standard units. Base units can be used to streamline the
setup of a conversion.

4 Note:
When you start preprocessing units of measure, all units that are derived from existing units
of measure are assigned to the Undefined class. For each shared unit of measure, you must
select a unit class other than Undefined . For a shared unit of measure, the unit class must be
identical on every line that is associated with the unit of measure.

5. Inthe System of units field, verify that the appropriate system of units is applied.
The field is set to None when company-specific units of measure are created manually. For units such
as box and piece,None is an appropriate system of units. However, if None is not appropriate for a
unit of measure, selectMetric or United States customary units . Examples of units of measure that
use the None category are Box and Pieces.

@ Note:
For a shared unit of measure, the system of units must be identical on every line that is
associated with the unit of measure.

6. ClickValidate to check for validation errors before you set the units of measure to ready for upgrade.
7. After you resolve all of the validation errors, click Set to ready for upgrade

Unit conversions

Unit conversions define formulas for converting between units of measure. One unit conversion can be
associated with each unit of measure.

Use the Preprocess unit conversions form to define how you want company -specific unit conversions
that exist for company-specific units of measure to be consolidated for shared units of measure.

A Note:
You must complete the definition of shared units of measure before you can start this task.
Click Units to define shared units of measure.

Microsoft Dynamics AX 2012 Upgrade Guide 39



Microsoft Dynamics AX

Company -specific unit conversions are consolidated

Eachcompany-specific unit of measure that was created in earlier versions of Microsoft Dynamics AX may
have an associated unit conversion. The shared units of measure that you define are based on company
specific units of measure. The associated unit conversins may differ from company to company. The unit
conversions can differ in one or more of the following aspects: factor, additional quantity, or rounding
information. You must consolidate the unit conversions for each shared unit of measure.

A Note:
You may change the factor, additional quantity, or rounding information for a shared unit
conversion, so that it differs from the factor, additional quantity, or rounding information in the
company-specific unit conversion. In this case, the existing data in thesystem is updated to reflect
the changes.

Consolidate the unit conversions for the shared units of measure

When you start preprocessing unit conversions, all conversions for each shared unit of measure are listed
in the Preprocess unit conversions form. Before you can consolidate the list of conversions, you must
make sure that the factor, additional quantity, and rounding information are identical for each unit
conversion. For example, if the conversion from centiliters (cl) to deciliters (dl) is specifiedon two lines,
and the rounding information is different on each line, you must align the rounding information for the cl

to dl conversion.

1. Click Unit conversions to open the Preprocess unit conversions form.
2. Inthe Factor, Additional quantity , and Round -off fields, verify that the information is identical if
more than one line has the same conversion formula.
7 Tip:
Click Product number or From unit (shared) to change the sort order of the columns.

@ Note:
An additional quantity can be used only with u nits that belong to the temperature unit class.

w

Click Validate to check for validation errors.
4. After you resolve all validation errors, click Set to ready for upgrade

Fixed units

System units define the units for length, mass, and volume that appear as suggested units of measure in
Microsoft Dynamics AX.

Use the Preprocess fixed units form to set up the system units.

A Note:
You must define shared units of measure before you can begin this task.

Shared system units replace fixed units

System unitsthat are shared across all companies now replace fixed units, which were used in earlier
versions of Microsoft Dynamics AX.

Set up system units
1. Click Fixed units to open the Preprocess fixed units form.
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2. Inthe Length, Mass, and Liquid volume fields, select the system units that you want to use.

A Note:
The units that you select must belong to the unit classes for length, mass, and liquid volume.
You assign units of measure to unit classes in thePreprocess units form.

w

Click Validate to check for validation errors.
4. After you resolve all validation errors, click Set to ready for upgrade

Unit texts

Unit texts are printed on external documents such as invoices. If no unit text is associated with a unit of
measure, the symbol of the unit of measure is applied.

Use the Preprocess unit texts form to define how company -specific unit texts that exist are consolidated
to a set of shared language-specific unit texts.

From Microsoft Dynamics AX onwards, the language is shared between companies and therds only one
shared language. For this reason, text in external documents is not automatically printed in company-
specific languages. To accommodate this change and preserve a representation of, for example units of
measure, in different languages, you mug create new unit texts. The new unit texts must be created for
each unit of measure in each of the languages that you want to be represented.

Set the unit texts for different languages

When you start preprocessing unit texts, all unit texts associated with each unit of measure are listed in
the Preprocess unit texts form. In cases where there is more than one unit text per language for a shared
unit of measure, the texts must be aligned so that there is only one text per language.
1. ClickUnit texts to open the Preprocess unit texts form.
2. Verify the text in the Unit field. If there is more than one unit text per language associated with a unit,
you must align the texts.
7 Tip:
To align unit texts, change the content of the Unit fields.

3. ClickValidate to check for validation errors before you set the unit texts to ready for upgrade.
4. Click Set to ready for upgrade when you have resolved all validation errors.

About purchase order upgrade

When you invoice in Microsoft Dynamics AX 2012, the accounting framework does not relieve any
accounting entries for accruals that were generated in an earlier version of the program. To upgrade to
Microsoft Dynamics AX 2012, you must first relieve any accrual entries that remain for purchase order
guantities received but not yet matched to vendor invoices.

To begin the upgrade, select the journal name. The journal name identifies the journal that make up the
relief of accruals for purchase order quantities received but not yet matched to vendor invoices.

A Note:
Set these parameters in Microsoft Dynamics AX 2009 to ensure that accounting entries are
generated. The accounting entries are generated for the accrual for purchase quantities received
but not yet matched to vendor invoices:
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1 Set the Post packing slip to led ger field to True in the Accounts payable parameters form.
1 Setthe Post accrued expense field to True in the item's item model group.

User relations upgrade - invalid company users

Users can be internal or external. Internal users include employees, and eternal users include vendors,
customers, and prospects. After you specify user relations, a user's information, such as the employee ID
or customer account ID, is automatically displayed in fields when that user opens a page in Enterprise
Portal for Microsoft Dynamics AX. For external relations, data in the selfservice portal for vendors is

tri mmed according to the userds designated account .

vendor account 1003, the user sees data only for that account inthe self-service portal for vendors.

Use the following procedure to delete user accounts for a company when the user ID is not valid.

Delete records when a user account has a an invalid ID

1. Click User relations upgrade 6 invalid company users .
2. Click Delete all .
3. Click Set to ready for upgrade

User relations upgrade missing contact person

Users can be internal, such as employees, or external, such as vendors, customers, or prospects. After you
specify wuser relati ons, mployeedDeor cistomer actonmnt ID)as autamaticdllys u ¢ h
displayed in fields when that user opens an Enterprise Portal page. For external relations, data is trimmed

on the vendor self-service portal according to account access. For example, if a user has an egtnal

relation for vendor account 1003, the user only sees data for that account in the vendor self-service portal.

Use this form to resolve issues when a user relation is not assigned a contact representative in your
business or organization.

Specify a contact for a user relation

1. Click User relations upgrade missing

2. Select a user in the list and then clickUser relations .

3. Click the General tab.

4. Use the Contact person drop-down list to select a contact representative in your business or
organization.

User relations upgrade duplicate user IDs

Users can be internal, such as employees, or external, such as vendors, customers, or prospects. After you
specify user relations, a userd6s informatioyed(such
automatically in fields when that user opens an Enterprise Portal page. For external relations, data is

trimmed on the vendor self -service portal, according to account access. For example, if a user has an

external relation for vendor account 1003, the user sees data for only that account in the vendor self-

service portal.

Use this form to resolve conflicts when multiple user relations are mapped to a single Microsoft Dynamics
AX user account. When each user relation has been assigned a unique MicrosofDynamics AX user
account, click Set to ready for upgrade
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Select which employee number to upgrade

If you used virtual companies in Microsoft Dynamics AX 2009, you might have two or more employee
records that are associated with the same Address book ID (fartyld). Microsoft Dynamics AX 2012 does
not support having employee records that share the same Address book ID (partyld). Before you upgrade
to Microsoft Dynamics AX 2012, for each set of employee records that share the same Address book 1D
(partyld), you must select one of the employee records to upgrade.

Select which employee records to upgrade

1. Inthe Preprocessing upgrade checklist , expand the Prepare application data for preprocessing
node and then select Select which employee number to upgrade

2. Inthe Select which employee number to upgrade  form, a list of employee records is displayed. This
list contains sets of records that share the same Address book ID (partyld). To indicate which records
should be upgraded, select the Selected check box for only one record in each set of records that
share the same Address book ID (partyld).

3. ClickView related data loss to open the Data loss for discarded Empllds form, where you can view
the data associated with the records that you did not select in step 2. This data will not be upgraded.

4. Click Close to return to the Select which employee number to upgrade  form.

5. Click Ready for upgrade .

Preprocess data on the live system

This section of the Preprocessing upgrade checklist contains data preprocessing tasks that can be
carried out on a live system. While these tasks are being performed, your business operations can
continue without interruption. The following sections are included.

Run live preprocessing scripts
Country/region upgrade

Party upgrade
Run delta preprocessing scripts

il
il
1
1

Run live preprocessing scripts

The Run live preprocessing scripts task opens the Upgrade live preprocessing form and displays the
scripts that will write prepared data into the shadow and dictionary tables that were created by the
Initialize preprocessing task. After you run the live preprocessing scripts, you must correct any issues that
are flagged with an error status in the grid. After you correct an issue, you must rerun the failed script, or
all failed scripts, until all live preprocessing scripts finish without error. You cannot proceed to running the
single-user mode preprocessing scripts until you resolve all live preprocessing script errors.

Run the live preprocessing scripts

Depending on the amount of data you are processing, running the live preprocessing scripts may take a
long time. The scripts run while your Microsoft Dynamics AX source system is live and being used for
production. This can slow system performance. To lessen the impact of preprocessing on your live system,
you can pause some or all of the scripts during business hours and resume them after business hours.
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A Note:
Some live preprocessing scripts cannot be paused. These scripts appear in the grid with a task
status of The task does not support pausing

Complete the following steps to begin running the live preprocessing scripts.

1. Inthe Preprocessing upgrade checklist , click Run live preprocessing scripts .
2. Inthe Upgrade live preprocessing form, click Run.

Pause and resume live preprocessing scripts
Complete the following steps to pause live preprocessing scripts.

1. Inthe Upgrade live preprocessing form, click Manage running tasks .
2. Inthe Manage running tasks form, do one of the following:

1 To pause a single script, select the script in the grid, and then clck Pause task.
I To pause all scripts, clickPause all tasks.

Complete the following steps to resume a paused script.

1. Inthe Upgrade live preprocessing form, click Manage running tasks .
2. Inthe Manage running tasks form, select a paused script in the grid, and then click Resume task.

Country/region upgrade

Earlier in the process, you used theDefault country/region  form to specify for a company the default
country/region to assign to address records that do not already have a specified country/region. For
example, you selected a default country/region for Fabrikam, and that country/region will be assigned to
any Fabrikam customer that does not already have a country/region selected for their address record. But
Fabrikam has customers in multiple countriesregions, and the default country/region will not apply to all
customers.

Use this form to change the country/region for individual addresses.

1. Click Country/region upgrade to open the Addresses with no country/region  form. The form
contains a list of addresses that do not have a country/region assigned.
2. Do one of the following:

1 To apply the same country/region to all the addresses in the list, select a country/region in the
Select a default country/region to apply  field, and then click Apply . You can filter the list and
then apply a default country/region to the records that are displayed.

9 To set country/regions for addresses individually, select the address and then select a
country/region in the Country/region field.

w

Update other address information as necessary.
4. Click the Set to ready for upgrade button.

Party upgrade

A party is a person or organization that can be internal or external to your organization. Each party has its
own record within Microsoft Dynamics AX. In Microsoft Dynamics AX 2012, every customer, vendor,
prospect, and competitor must be categorized as either a person or an organization. When you are
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upgrading to Microsoft Dynamics AX 2012, all customer, vendor, prospect, and competitor records are
assigned the party type Organi zation by default.

Use this form to indicate any customers, vendors, prospects, and competitors that should be categorized
as aPerson party type and to verify the name components for each Person party record. You can also use
this form to specify the name sequence, for example, First, Middle, Last, that will be used on &erson
party record. Person party records also include contacts and employees.

1. Click Party Upgrade to open the Party upgrade form.

2. Inthe Select the default person name sequence field, select the sequence in which you want names
to be displayed for a Person party record.

3. Inthe Type field, update any party records whose record type is changing from Organization to
Person.

4. After you have updated all your party records, click Set to ready for upgrade

Run delta preprocessing scripts

You run the delta preprocessing scripts after you complete the Global address book country/region
upgrade task on the Microsoft Dynamics AX source system. The delta preprocessing scripts check for
changes to the production data that have occurred since you started running the live preprocessing
scripts. Then, like the live preprocessing scripts, the delta scripts process the updated data into the
shadow and dictionary tables.

Like the live preprocessing scripts, the delta preprocessing scripts run while your Microsoft Dynamics AX
source system is live and being used for production. To optimize performance, you can pause some or all
of the delta scripts by using the Manage running tasks form.

M Note:
Some delta preprocessing scripts cannot be paused. These scripts appear in the grid with aTask
state that says The task does not support pausing

You can run the delta preprocessing scripts multiple times until you are ready to enter single-user mode.
To minimize downtime, make sure to run the delta preprocessing scripts just before entering single-user
mode.

Run the delta preprocessing scripts

1. Inthe Preprocessing upgrade checklist , click Run delta preprocessing scripts .
2. Inthe Upgrade delta preproce ssing form, click Run.

Pause and resume the delta preprocessing scripts

Complete the following steps to pause delta preprocessing scripts.

1. Inthe Upgrade delta preprocessing form, click Manage running tasks .
2. Inthe Manage running tasks form, do one of the following:

1 To pause a single script, select a running script from the grid, and then click Pause task.
1 To pause all running scripts, clickPause all tasks.

Complete the following steps to resume a paused script.

1. Inthe Upgrade live preprocessing form, click Manage running tasks .
2. Inthe Manage running tasks form, select a paused script from the grid, and then click Resume task.
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Preprocess data in single -user mode

This section of the Preprocessing upgrade checklist contains data preprocessing tasks that must be
performed in single -user mode. Your system is offline for non-administrative users from now until the end
of the upgrade process. The following topics are included.

I Enter into single-user mode
I Run single-user mode preprocessing scripts

Enter into single -user mode

You enter into single-user mode on the Microsoft Dynamics AX source system to make sure that the
system is unavailable for busines use. In singleuser mode, only an upgrade user who has administrative
permissions is connected. No other users can start a client session when the source system is in final
preprocessing and source data is being bulk copied to the Microsoft Dynamics AX 2012 target system.
After you enter into single -user mode, you can run the single-user mode preprocessing scripts and begin
bulk copy of data to the target system.

In this step, you will do the following:

1 Enter into single-user mode and end current user sessions by using the Online users form.

1 Reopen client sessions for an administrative user on a single instance of the AOS (Microsoft Dynamics
AX 4.0 only).

1 Back up the source system database.

1 Set the Microsoft SQL Server database recovery model tosimple.

Enter single -user mode and end current user sessions

To enter single -user mode

1. Inthe Preprocessing upgrade checklist , click Enter into single -user mode .

2. Click Administration > Forms > Online users.

3. Click the Server Instances tab to see a list of all instances of the AOS that are running.

4. Select a server instance, clickReject new clients , and then click OK to confirm that you want to stop
the AOS from accepting new client sessions.
In the Status column, the status changes to Draining . This staus means that no users can start a new
client session in the AOS instance. However, rejecting new clients does not end any current sessions.

6. Repeat step four for all server instances that are running.

After you set the AOS instances to reject new clientsessions, end all current client sessions. Before you do,
make sure that all users who have active client sessions have finished their work.

To end client sessions

1. Inthe Online users form, click the Client Sessions tab.

2. Select the user sessions hat you want to end (other than a single administrative user session), and
then click End sessions.

3. Inthe End sessionswindow, click OK, and then click Close.

Reopen client sessions to set up batch threads in Microsoft Dynamics AX 4.0

The client-based batch framework in Microsoft Dynamics AX 4.0 supports only a single batch thread for
each active client session. If you are upgrading from Microsoft Dynamics AX 4.0, you can open up to eight
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user sessions to allow multiple batch threads. These batch thread are necessary for running the final
preprocessing scripts and bulk copying data to the target system. All user sessions must be opened by an
upgrade user who has administrative permissions. Open these client sessions on a single AOS instance.

To allow ne w client sessions

1. Inthe Online users form, click the Server instances tab.

2. Select a server instance, and then clickAccept new clients .
After you begin running the preprocessing upgrade scripts in the next checklist task, Run single -user
mode prepro cessing scripts, you can open the new client sessions for batch threads on Microsoft
Dynamics AX 4.0. If you open additional sessions before starting the script run, the run will fail.

3. After you have opened the client sessions that you need for batch threads, return to the Online users
form and click Reject new clients to prevent additional sessions from being opened.

&

Warning:

If you allow reopening client sessions in Microsoft Dynamics AX 4.0, you must take steps to
ensure that no other users log on to make transactions when preprocessing scripts are being run
and bulk copy is in progress. If any transactions are made on the Microsoft Dynamics AX source
system during this time, your data will be invalid and the upgrade will fail.

Back up the source syst em database

Back up the source system SQL Server database to protect your data from any loss that may be caused by
unexpected issues during single-user mode preprocessing. The backup also sets the initial recovery point
for the simple recovery model that y ou will set for your SQL Server database during this stage of upgrade.
To find the procedures for backing up your SQL Server database, use the following links:

1 To back up a SQL Server 2008 database, seldow to: Back Up a Database (SQL Server Management

Studio)
1 To back up a SQL Server 2005 database, sedow to: Back Up a Database (SQL Server Management

Studio)

Set the Microsoft SQL Server r ecovery model to simple

Before you begin final preprocessing on the source system, set the source system SQL Server recovery
model to simple. By setting the recovery model to simple, you permit the high -performance bulk copy
process that is optimal for run ning the single-user mode preprocessing scripts and bulk copy of the
source data to the target system.

1. Open Microsoft SQL Server Management Studio Start > All Programs > Microsoft SQL Server
[version] > SQL Server Management Studio ).

In Object explo rer, select the database to open the Database properties - <database name> form.
In the Select a page pane, click Options .

In the Recovery model list, selectSimple.

Click OK.

ar 0N

Run single -user mode preprocessing scripts

Run single -user mode preproc essing scripts is the final task in the Preprocessing upgrade checklist .
This task first checks that the system is running with only a single administrative user logged in. If this test
is successful, theUpgrade single -user preprocessing form opens. Clicking Run on this form launches
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the delta upgrade scripts for a final time and then launches the upgrade scripts that prepare data to be
bulk copied to the target system. These scripts run using setbased operation.

Use parallel processing to reduce downtim e

Single-user mode operation of your Microsoft Dynamics AX system means that the system is unavailable
for business transactions. The upgrade framework enables parallel processing of the source system data in
order to keep downtime to a minimum. If you are upgrading from Microsoft Dynamics AX 2009, this
checklist task will initiate parallel processing of the data automatically. If you are upgrading from

Microsoft Dynamics AX 4.0, you can manually initiate parallel processing.

When you run single-user mode preprocessing on a Microsoft Dynamics AX 4.0 system, each client
connection enables a single batch thread to run. To run multiple batch threads and improve performance,
you allow the system to accept new connections, and then open multiple clients using th e administrative
login. While the system is accepting new connections, you must insure that no non-administrative users
connect and make transactions. Any transaction made after you enter single-user mode will invalidate the
data and the upgrade will fail. Also, if the source system uses multiple instances of the application object
server (AOS), you must make sure that only one instance of the AOS allows new connections.

For more information, see Enter into single-user mode.

Prepare for single -user mode preprocessing

Before you run the single-user mode preprocessing scripts, back up the Microsoft SQL Server database
and set the database recovery model to simple. For more information about how to prepare for running
the single-user mode preprocessing scripts, seeEnter into single-user mode.

Single-user mode preprocessing scripts on the source system run concurrently with the bulk copy of data
to the Microsoft Dynamics AX 2012 target system, synchronization of the Microsoft SQL Server database
on the source system, and post synchronization of the database. This process will take several hours.

Run the single -user mode preprocessing scripts

Complete the followi ng steps to run the single-user mode preprocessing scripts and complete the tasks
on the Preprocessing upgrade checklist .

1. Inthe Preprocessing upgrade checklist , click Run single -user mode preprocessing scripts .
2. Inthe Upgrade single -user preprocessing form, click Run to start running the single -user mode
preprocessing scripts.

Additional upgrade preprocessing tasks

This section contains topics describing additional upgrade tasks on your Microsoft Dynamics AX source
system. Depending on your Microsoft Dynamics AX setup and your upgrade planning, these tasks may be
optional or required after completion of the standard tasks in the Upgrade preprocessing checklist

I About Lean manufacturing migration
I About multisite activation readiness
9 Using the preprocessing upgrade state transfer tool
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About Lean manufacturing migration

This topic describes the migration scenario for Microsoft Dynamics AX 2012 Lean manufacturing. There is
a new data model, so there is no code upgrade needed. However, before you upgrade to Microsoft
Dynamics AX 2012, you must migrate the Lean manufacturing for Microsoft Dynamics AX 2009data to the
new model. This scenario requires that you complete the following pre-upgrade tasks:

1. Create the Microsoft Dynamics AX 2012 Lean manufacturing framework and set up the necessary
base data.

2. Prepare the current version data for migration to the Microsoft Dynamics AX 2012 Lean
manufacturing framework.

You perform these tasks in the following forms:

1 Convert kanbans to next version kanban rules  form & Use this form to convert the current version
kanban rules to the next version. To open the form, click Preprocessing upgrade checklist >
Prepare application data for preprocessing > Prepare kanbans for migration . SeeConvert
kanbans to next version kanban rules (form)for more information.

1 Convert LOS-BTO schedules to next version kanban rules form & Use this form to convert the
current version LOS schedules to the next version. To open the form, clickPreprocessing upgrade
checklist > Prepare application data for preprocessing > Prepare LOS schedules for migration
SeeConvert LOSBTO schedules to next version kanban rules (form)for more information.

Create the Lean manufacturing framework

The Microsoft Dynamics AX 2012 Lean manufacturing data structures consist of production flows and
production flow activities. To create these and set up the associated data, complete the following tasks. In
the Convert kanbans to next version kanban rules  form, or alternatively, in the Convert LOS-BTO
schedules to next version kanban rules  form, click Next version base data , and then select the
appropriate form.

1 Inthe Production flow model form, create and configure production flow models. These models
define: the capadty settings for work cells and the display settings that are used in the kanban boards.
SeeProduction flow model upgrade (form) for more information.

1 Inthe Lean manufacturing next v ersion value streams form, define the value streams that are used
to classify and aggregate lean financial transactions. Each new production flow references a value
stream. During the upgrade process, the value streams are converted to operating units. SeeLean
manufacturing next version value streams (form) for more information.

1 Inthe Standard workdays for calendar form, define the length of a standard work day, in hours, for
the current calendars. To measure work cell capacity in periods that consist of hours and minutes, you
must define this in the calendars. SeeStandard work days for calendar (form) for mor e information.

1 Inthe Work cells migration form, define additional settings for current work cells that are to be
upgraded. The additional, mandatory settings to define are as follows: input warehouse and location,
output warehouse and location, and produc tion flow model. See Work cells migration (form) for more
information.

91 Inthe Production flows form, create production flows and production flow activities that identify and
describey our company®6s basic business processes and prodtl
activities and you can define transfer activities. Create activity relations to link activities and establish a
production flow sequence. See Production flows upgrade (form) for more information.

1 Inthe Lean manufacturing next version parameters  form, define the additional production
parameters for Lean manufacturing. These parameters are used to crate production flows and
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generate kanban jobs during the upgrade process. SeeLean manufacturing next version parameters

(form) for more information.

1 Inthe Lean schedule groups form, define the lean schedule groups that are used to aggregate items

Microsoft Dynamics AX

for production at a particular work cell. See Lean schedule groups upgrade (form)for more

information.

Prepare the current version data for migration

When the Microsoft Dynamics AX 2012 Lean manufacturing framework is created and the base data is set

up, you prepare the current version data for migration to the next version. Use the Convert kanbans to
next version kan ban rules form to prepare the current version kanban rules. Alternatively, use the

Convert LOS-BTO schedules to next version kanban rules

schedules.

form to prepare the current version LOS-BTO

Review the current rules and map them to the Microsoft Dynamics AX 2012 Lean manufacturing
framework. The following table gives an overview of the core concepts in Lean manufacturing for
Microsoft Dynamics AX 2009 and the corresponding concepts in Microsoft Dynamics AX 2012 Lean
manufacturing. Use this information to guide you when you map the current kanban rules.

Microsoft Dynamics

Microsoft

Conversion of

Conversion of

Conversion of

AX 2009 feature Dynamics AX 2012 | business rules active transactions handling units
feature
Fixed quantity kanban | Fixed quantity Supported Supported Supported
kanban
Subcontracting kanban | Fixed or scheduled Convert to Supported Supported
kanban manufacturing kanban
Purchase kanban Withdrawal kanban | Convert to withdrawal | Supported Supported
from a warehouse kanban
location that has the
item coverage type,
Purchase order
1 PTO (pultto- 1 Event kanban Supported Supported Not applicable
order) kanban 1 Sales event
T Sales  Kanban line
Y Kanban
Target kanban Scheduled kanban Supported Supported Supported
Phased target kanban | Scheduled kanban Supported Supported Supported
Family grouping and Item allocation key Supported Not applicable Not applicable
item grouping
Family grouping and Lean schedule group | Supported Not applicable Not applicable
item grouping
Kanban group code Kanban card number | Supported Not applicable Not applicable

sequence

Kanban template

All kanban types

Through item
allocation key

As kanban type

As kanban type

Generic kanban

Not applicable. Use
the Product
configurator for
configurable items.

Upgraded as a normal
kanban rule without
extended data.

Kanban is upgraded

as normal fixed

quantity kanban.

Not applicable
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Microsoft Dynamics AX

Microsoft Dynamics
AX 2009 feature

Microsoft
Dynamics AX 2012
feature

Conversion of
business rules

Conversion of

active transactions

Conversion of
handling units

T LOS6BTO
schedule

First level

T Level 2n

1  Event kanban

1 Sales event
kanban

 Kanban line
event

Supported

Supported

Not applicable

LOS cumulative
schedule

Production schedule
and Supply
schedule form

No specific setup is
required to use the
Supply schedule form
and work with
planned orders

Not applicable. The

schedule is

established during

the next master
planning run.

Not applicable

@ Note:

During the bulk upgrade process, the Microsoft Dynamics AX 2012 Lean manufacturing kanban
rules are generated.

About multisite activation readiness

The upgrade readiness check performs a series of configuration analysis tests to identify issues that could
potentially affect data upgrade . These checks include verification that the multisite configuration is setup
correctly. This includes verifying that the site and warehouse hierarchies are specified.

9 Important:

The upgrade readiness tests will not complete until the site structure is configured.

The following tables list and describe the conditions and requirements for multisite activation that the

readiness check tests for. These tests ensure that the activation process is completed without errors.

Description Conditions Requirement

Site and warehouse relations None A site is assigned to all warehouses.

Site and warehouse relations None Warehouses only refer to quarantine
warehouses that are located on the
same site.

Site and work center relations None All work centers are linked to a site.

Site and production unit relations None All production units are linked to a site.

Site and production unit relations None Production units only refer to picking
warehouses or storage warehouses that
are located at the same site.

Site and production unit relations None All work centers that are associated

with a production unit are linked to the
same site as the production unit.

Physical inventory dimension group
setup

1  More than one site is defined.

1 Aninventory dimension group

exists where thewarehouse

dimension is not set to Physical

inventory .

For each item that uses this dimension
group, all transactions are related to the
same site. Otherwise, some sites may
have with negative inventory values.
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Financial inventory dimension group
setup

1 More than one site is defined.

1 Aninventory dimension group
exists where the warehouse
dimension is not set to
Financial inventory .

For each item that uses this dimension
group, all transactions are related to the
same site. Otherwise, the cost may
change.

Financial inventory dimension group | None Activation will not result in cross-site
setup markings.
Deleted warehouses None Closed inventory transactions do not

refer to a warehouse that has been
deleted. InventDim records cannot
refer to a deleted warehouse.

H Notes:

If this check fails, the
validation displays a list of any
deleted warehouses.

You will have to re-create
these warehouses, assign them
to a site, and then re-run the
upgrade readiness check.

After the upgrade is complete,
you can delete the warehouses
again, because no transactions
are created for these
warehouses during the
activation process.

Inventory dimensions in virtual
companies

One or more virtual companies exist.

Tables that contain InventDimlId fields
are not shared across companies.

Intercompany configuration

Intercompany endpoints are
defined.

For all intercompany action policies, the
value mapping of the handling
warehouse that is defined in the
document configuration is set to not
specified.

Site and task group relations

None

All work centers in a task group belong
to the same site. This site must be the
same site that is defined on the task

group.

Site and task group relations

None

All task groups are assigned only to
work centers located on the same site.

Site and bill of materials relations

None

All warehouses that are defined in the
bill of materials are associated with the
same site. Master planning assumes 0
(zero) days for picking.

Site and bill of materials relations

None

If a site is defined in the BOM version,
all warehouses that are defined in the
BOM belong to that same site.

Site and route relations

None

All work centers that are defined in a
route belong to the same site.
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Site and route relations

None

A task group that is assigned to a route
contains only work centers that are
assigned to the same site as the work
centers that are defined in the route.

Site and route relations

None

All work centers that are defined in a
route version belong to the same site.

Site and route relations

None

For each route version that is assigned
to a site, all work centers that are
defined in the route belong to the same
site.

Shipment setup

A warehouse is not defined on the
shipment

Multisite cannot be activated. You must
either complete or cancel the shipment
before you upgrade.

Shipment template setup

A warehouse is not defined on the
shipment template

Multisite cannot be activated. You must
add a warehouse to the shipment
template before you upgrade.

Fallback warehouse None A fallback warehouse is selected on the
Other tab in the Company
information form.

Inventory dimensions None Inventory dimension combinations do

not include both the site dimension and
the warehouse dimension.

|j Note:

This check will fail when there
is a defect in the application.
To recover, you must manually
clean up the Inventory
Dimension table.

Additional readiness checks

The following table describes additional readiness checks that the validation performs.

Description

Conditions Requirement

Site and production order relations

None Open production ord ers do not span multiple sites.

|j Notes:

If this check fails, the validation displays a
list of the production orders that span
multiple sites.

You must end these production orders
before upgrading.

Empty intercompany inventory dimensions None The intercompany inventory dimensions table is
empty. This table is used only for temporary storage
of data.

Empty intercompany inventory summary None The intercompany on-hand inventory table is empty.

This table is used only to store data temporarily.

Empty quarantine orders

None All quarantine orders are associated with a
warehouse.
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Empty inventory summary delta None The on-hand inventory changes table is empty. This
table is used only to store data temporarily.

Empty inventory summary delta dimension None The on-hand inventory checks table is empty. This
table is used only to store data temporarily.

Inventory transaction ID on the same site None All open inventory transactions with the same

inventory transaction ID, or Lot ID, are associated
with the same site.

H Notes:

If this check fails, the validation displays a
list of the lot IDs for which inventory
transactions will be split across multiple
sites.

You must close these inventory
transactions by financially updating the
parent transaction before proceeding with
the upgrade.

Empty transfer journal lines None A warehouse is assigned to all transfer journal lines.

Empty inventory transfer lines None A warehouse is assigned to all inventory transfer
lines.

Empty warehouse management orders None A warehouse is asigned to all warehouse
management orders.

Empty warehouse management order None A warehouse is assigned to all warehouse

transactions management order transactions

Using the preprocessing upgrade state transfer tool

The preprocessing upgrade state transfer tool helps you minimize downtime during upgrade. The tool
also helps you avoid putting an additional load on your production Microsoft Dynamics AX system while
you prepare to upgrade it. This topic describes how to create a test system that is a repiica of your
production system, perform data preprocessing on the test system, and then transfer the completed
preprocessing state back to the production system.

How the state transfer tool works

The state transfer tool operates on a Microsoft Dynamics AX urce system where some of the tasks of

the Preprocessing upgrade checklist have been completed. The tool analyzes the code in the upgrade
preprocessing project to identify the upgrade staging and framework tables that are required to capture

the state of the Preprocessing upgrade checklist . The tool then uses the Microsoft SQL Server Bulk Copy
Program (BCP) utility to copy these tables to a second Microsoft Dynamics AX source system. During bulk
copy, you can add processor threads to improve data throughput.

Plan before you use the state transfer tool

The state transfer tool is intended to help minimize the amount of upgrade preprocessing that must be
performed on a production system. Use the state transfer tool if you want to offload the live upgrade
preprocessing task to a test server. However, note that use of this tool requires careful consideration and
planning. We recommend that you test the tool on a non -production system before you use it for
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upgrade in your production environment. Also, after you p erform a state transfer, you must reconcile the
updated data in your test system with the data in your production system.

Prepare to perform a state transfer

Before you perform a state transfer, you must complete the following tasks on the test and product ion
source systems.

Prepare the production system

1.

On the production system, import the preprocessing XPO that is appropriate for the Microsoft
Dynamics AX version that you are upgrading. For more information, see the Microsoft Dynamics AX
2012 Upgrade Guide.

On the production system, install the upgrade -related label file (.ald) files. Also install the upgrade-

related Help files (.chm) files. For more information, see theMicrosoft Dynamics AX 2012 Upgrade

Guide.

On the Preprocessing upgrade checklist , complete the Check upgrade readiness task and resolve

any validation errors. Enable triggers to track necessary data, based on pronpts from the upgrade

readiness checks. For more information about this step, seeCheck upgrade readiness

The test system must be an exact replica of the production system. Copy the USR layer (.aod) i on

the production system, and back up the production system database:

a. Copy the USR layer (.aod) file. Typically, this file is located at ©@rogram Files (x86)Microsoft
Dynamics AX40\Application\<application instance>\axusr.aod or C\Program Filea Microsoft
Dynamics AX50\Application\<application instance>\axusr.aod. Have this file available for
installation on the test system.

b. Use Microsoft SQL Server Management Studio to back up the Microsoft Dynamics AX database.
Have this backup file availablefor installation on the test system.

Important:

After you copy the USR layer and make backup of the database, you must avoid making changes
to the application on your production system. Data transactions may continue (allowing

continued business operations), but metadata changes, customizations, changes to the AOT, and
anything that changes the behavior of the application can cause the state transfer to fail.

Prepare the test system

The following steps produce a test source system that is configured identically to the production source
system.

@ Warning:

Do not import the upgrade XPO into the test source system. The necessary upgrade framework
code is provided in the AOD file that you copied from the production source system. Importing
the XPO overwrites eement IDs and causes runtime errors.

Install the upgrade-related label files (.ald) files. Also install the upgrade related Help (.chm) files. For
more information, see the Microsoft Dynamics AX 2012 Upgrade Guide

Install the USR layer (.aod) file that you copied from the production system. Typically, this file is
installed at CAProgram Files (x86YMicrosoft Dynamics AX\40\Application\Appl\Standard\axusr.aod or
CAProgram Files Microsoft Dynamics AX50\Application\Appl\DynamicsAX8axusr.aod.

Use SQL Server Management Studio to restore the database backup from the production system as
the Microsoft Dynamics AX database on the test system.
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0 Important:
After you complete these steps, you must restart Application Object Server (AOS).

The test source system is now ready for upgrade preprocessing. We recommend that you complete the
following tasks on the Preprocessing upgrade checklist :

1. Alltasks in the Prepare application data for preproce  ssing section
2. Run live preprocessing scripts
3. Run delta preprocessing scripts

Enable the database connection

Windows integrated security is used to connect to the production source system from the test source
system. The administrative user who is peforming the state transfer must have access to the Microsoft
Dynamics AX database on the production source system. Otherwise, the production source system rejects
the database connection. Open SQL Server Management Studio on the production source system, ad
follow these steps:

1. Grant access to the Microsoft Dynamics AX database to a domain user who has administrative
privileges on the test source system.
2. Add this user to the db_owner and public database roles.

Open the Preprocessing upgrade state tran sfer form

After you have completed upgrade preprocessing on the test system, open the Preprocessing upgrade
state transfer form on the production system. The form is opened from a private project that is installed
by the preprocessing framework XPO.

1. Click the Project icon on the Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 toolbar.
2. ExpandPrivate .

3. Double-click xferUpgState (usr) .

4. Scroll down to xferUpgState (usr) , right-click, and then click Open.

Perform the state transfer

1. Inthe Server name field, enter the name of the test system.

2. Inthe Database name field, enter the name of the Microsoft Dynamics AX database for the test
system.

3. ClickRun to start the upgrade state transfer. The state transfer tool validates conditions in both the
test system and the production system. If no errors are found, the tool schedules batch jobs to bulk
copy all shadow, dictionary, auxiliary, and framework tables from the test source system to the
production source system.

A form opens so that you can monitor and manage the bulk copy process. The form is called Batch list in
Microsoft Dynamics AX 4.0 andBatch tasks in Microsoft Dynamics AX 2009. You can use the form to
pause or rerun jobs if you have to.

0 Important:
To use the state transfer tool, you must enable administrative user access between the test and
production systems by using Windows integrated security.
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Perform post -transfer tasks

After the state transfer is complete, run open the Preprocessing upgrade checklist and rerun the tasks in
the section Prepare application data for preprocessing . This will allow you to make manual adjustments
to new data from the delta between production system backup and completion of the state transfer.
Finally, run the delta preprocessing scripts, and then continue with upgrade preprocessing in single -user
mode.
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Create the target system

This section documents the installation and configuration of Microsoft Dynamics AX 2012 on a target
computer system as part of upgrade. Installation on the target system is performed separately from
procedures carried out on the source system, and may be done concurrently with data upgrade
preprocessing. The following sections are included.

9 Verify that you have the required permissions for installation
I Set permissions specific to upgrade
9 Install Microsoft Dynamics AX (upgrade)
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Verify that you have the required permissions f  or

installation

Before beginning the Microsoft Dynamics AX installation process, work with a system administrator to
ensure that the account you log on with at each server has appropriate permissions. The permissions
listed below are implemented according to the principle of least privilege.

In all cases, you must be a member of the Administrators group on the local computer where you are
installing a component. The following table lists permissions that are required in addition to administrator

access onthe computer.

Component

Additional permissions required to install

Databases

Member of the dbcreator role on the SQL Server instance.

If you are installing the databases remotely from a computer other than the
database server, you must log on to the remote computer with an account
that is an administrator on the SQL Server computer. Setup requires access tc
SQL Server services.

Application Object Server (AOS)

Member of the securityadmin role on the SQL Server instance you want to
connect to.

Enterprise Portal

1  Member of the System administrator role in Microsoft Dynamics AX
1  Member of the Administrators group in Windows on the Web server

1  Member of the Farm Administrators group in Microsoft SharePoint
2010 products

1  Member of the dbcreator role on the SQL Srver instance being used
for SharePoint 2010 products

1 Member of the WSS_Content_Application_Pools database role in the
SharePoint_Config database

Enterprise Search

1 Member of the System administrator role in Microsoft Dynamics AX
1 Member of the Administrat or group in Microsoft SharePoint Services

1 Member of the dbcreator role on the SQL Server instance being used
for Microsoft SharePoint Services

Help server

Member of the System administrator role in Microsoft Dynamics AX.

Reporting Services extensions

Member of the System administrator role in Microsoft Dynamics AX.

Analysis Services configuration

Member of the SQL Serverdb_accessadmin role for the Microsoft Dynamics
AX database.

Client None
Office add-ins None
Remote Desktop Services integration | None
Debugger None
Visual Studio Tools None
Trace Parser None

Web services on IS

Member of the System administrator role in Microsoft Dynamics AX.

.NET Business Connector

None

Synchronization proxy

Member of the dbowner database role on the SQL Server dtabase for
Microsoft Project Server.
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Component Additional permissions required to install
Synchronization service Member of the System administrator role in Microsoft Dynamics AX.
Management utilities None

Set permissions specific to upgrade

Before you begin the Microsoft Dynamics AX installation process, work with a system administrator to
ensure that the account you log on with at each server has the following permissions that are specific to
upgrade. These permissions are implemented according to the principle of least privilege.

Set permissions

The following table lists permissions that must be set for upgrade.

Component Additional permissions required

Upgrade checklists Member of the SYSADMIN role in Microsoft Dynamics
AX.

Source database (the database that will be upgraded to Same domain user (using Windows integrated security)

Microsoft Dynamics AX 2012) must have ownership privileges on both the source
Microsoft Dynamics AX and target Microsoft Dynamics
AX 2012 databases.

Install Microsoft Dynamics AX (upgrade)

You must install Microsoft Dynamics AX 2012 on a new server computer before completing the upgrade
from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009. For complete installation instructions,
refer to the Microsoft Dynamics AX Installation Guide

9 Important:
Be sure to selectRegister database for upgrade as an option during installation.
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Upgrade the target system

This section documents how to upgrade a newly installed Microsoft Dynamics AX target system. These
procedures must be coordinated with those described in the section Preprocess data on the source
system. The following sections are included.

Y Perform code upgrade
| Perform data upgrade
I Upgrade Enterprise Portal
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Perform code upgrade

A new Microsoft Dynamics AX 2012 system that is registered for upgrade displays theSelect the
appropriate upgrade checklist  form on startup. This is unlike a new default installation, which displays
the Initialization checklist on startup. Use the Select the appropriate upgrade checklist  form to begin
either code upgrade or data upgrade on your target system. If your source system contains customized
application code, you must perform code upgrade on your target system in order to preserve your
customizations. Code upgrade, if it is required, must be performed before data upgrade. The seledor
form will continue to appear on startup until the data upgrade tasks have been completed.
7 Tip:
If you have no custom code to upgrade, select Data upgrade checklist now in the Select the
appropriate upgrade checklist form. For more information, see Perform data upgrade.

Select a code upgrade checklist
Microsoft Dynamics AX 2012 supports two code upgrade scenarios:

1 You are upgrading code from a Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 sytem
that contains application code in AOD (.aod) files.

1 You are upgrading from a version of Microsoft Dynamics AX that uses models instead of AOD files.

The Select the appropriate upgrade checklist ~ form offers a code upgrade checklist that corresponds to

each scenario:

1 AOD code upgrade checklist

1 Model code upgrade checklist

Select the correct option for your scenario and then click OK. The checklist that opens will guide you
through the required tasks.

Additional information about code upgrade

For more information about how to upgrade code, see Microsoft Dynamics AX 2012 White Papers: Code
Upgrade on the Microsoft Download Center.

Complete the code upgrade tasks

The rest of this section describesthe tasks that you must complete to import and upgrade your
customized code on the Microsoft Dynamics AX 2012 target system.

Provide license information

Import Microsoft AOD files into the baseline model store
Import Microsoft -signed model files into baseline model store
Import AOD files into the baseline model store

Import AOD files into the new model store

Import label files into the new model store

Import layer model(s) into baseline model store

Import layer model(s) into new model store

Restart Application Object Server

Compile the application (upgrade)

Detect code upgrade conflicts

= =4 =4 =4 -8 -4 -8 4 -4 -4 -4
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1 Compile into .NET Framework CIL

Provide license information

To be able to use Microsoft Dynamics AX, the administrator must enter license information. By entering
license codes, you enable the general functionality covered by the license. Then, you can enable or disable
access to more specific features by changing configuration keys.

A Note:
If you change the current license settings because license keys are updated, the new functionality
will not be available until the client is restarted.

In addition to license codes for Microsoft Dynamics AX functionality, there are licenses for access to the
Microsoft Dynamics AX development environment. For more information, see the Developer Help,
available from the Microsoft Dynamics AX Help menu.

If you do not have a license, you can set up Microsoft Dynamics AX in demonstration mode.
Demonstration mode provides all the functionality of Microsoft Dynamics AX, and enables all
configuration keys by default.

Language -specific licenses
If your license includes specific languages, you must restart the AOS after importing the license file or

entering license information. Restarting the AOS ensures that the correct languages are listed in the
Options form (Microsoft Dynamics AX > Tools > Options...).

If you do not restart the AOS, end users will be able select unlicensed languages, which would pevent the
Microsoft Dynamics AX client from starting.

Import license information

1. License information

2. Click Load license file to import the license codes from a file.
The Load license file dialog box appears.

3. Click the folder icon and browse for the license file.

A Note:
We recommend that you store the license file in a secure location that is known only to
Microsoft Dynamics AX administrators.

4. Click OK. A message appears, asking whether you want to synchronize the database.
Click Yes.
6. Close the License information window.

o

Enter license information

As an alternative to importing the license information, you can enter the license information manually.

1. License information

2. Enter the name of the license holder, the system's serial numbe, and the expiration date. The
information is in the license document.

3. Onthe System tab, enter the license code and verify that the Status field displays the expected text.
The license code indicates whether you have a standard, professional, or entgprise solution.
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The first four entries (name of the license holder, the system's serial number, expiration date,
and license code) determine what appears in the remaining codes. Therefore, they must be

entered correctly.

4. Enter the remaining codes. For each, review theStatus field to make sure that the code is accepted.

Import Microsoft AOD files into the baseline model store

Import Microsoft application files, or .aod files, from the source system into the baseline model store.

Use the following procedure to import .aod files into the baseline model store.

1. On the server, create a folder named Old in the following location: %ProgramFiles% Microsoft
Dynamics AX60\ServeAMicrosoftDynamicsAX\bin\Application\Appl\Standard.

2. Copy the Microsoft .aod files from the source system to the Old folder.

3. Some layers have been renamed in Microsoft Dynamics AX 2012. Rename each .aod file to the new
name of the layer in Microsoft Dynamics AX 2012. The following table shows the names of the layers
in different versions of Microsoft Dynamics AX.

Microsoft Dynamics AX 4.0 layer Microsoft Dynamics AX 2009 Microsoft Dynamics AX 2012
layer layer (Rename to this)
axbup.aod axbup.aod axisp.aod
axbus.aod axbus.aod axisv.aod
axlop.aod axsl3.aod axslp.aod
axlos.aod axsl2.aod axsin.aod
axdip.aod axsll.aod axfpp.aod
axdis.aod axhfx.aod axfpk.aod

4. In the Import Microsoft AODs into the baseline model store

dialog box, select the name of the

layer file that you want to import. When you import layers, you must start wit h the lowest layer.
5. Click OK to import the .aod file.

If the .aod file contains items that cannot be imported, an Infolog message is displayed. For more
information, see the log file referenced in the message. Usually, an application object cannot be
imported for one of the following reasons:

1 A method was added to a class that no longer exists in the Application Object Tree (AOT).
1 Thereis an ID conflict between two elements that have the same name and type, but different IDs.
1 You customized a hybrid classor a table that supports inheritance.

To resolve these issues, identify the application objects that were not imported from your Microsoft
Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system. Export all of these application objects to an
.xpo file. Thenimport the .xpo file into the Microsoft Dynamics AX 2012 system by clicking Import on
the AOT toolbar.

Continue with the next steps in the code upgrade checklist.

o

0 Important:
You must first import the layers that Microsoft owns. You can then import the rem aining layers one at
a time, starting with the lowest layer.
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-signed model files into baseline model store

Import the model files that are signed by Microsoft into the baseline model store by using the AxUtil

command-line utility.

Use the following procedure to import Microsoft-signed model files into the baseline model store.

1. On the target system, import the Microsoft -signed model files that you received from Microsoft by
using the AxUtil import command-line utility. For example, to import the Foundation model into the
MicrosoftDynamicsAXBaseline model store, type the following command:

AxUtil import /file:"Foundation.axmodel" /db:MicrosoftDynamicsAXBaseline

For more information about the AxUtil import utility, see the help for AxUtil by typ i nAgx Wt i |

2. After you have imported all of the Microsoft -signed models, continue with the next steps in the code

upgrade checkilist.

0 Important:

You must import Microsoft-owned models before other models. Then import the remaining models
one at a time, starting with the lowest layer.

Import AOD files into the baseline model store

Import the .aod file for the layer that you want to upgrade from the source system into the baseline

model store.

Use the following procedure to import AOD files into the bas eline model store.

1. On the server, create a folder that is named Old in the following location:
%ProgramFiles%Microsoft Dynamics
AX\60\ServeiMicrosoftDynamicsAX\bin\Application\Appl\ Standard

Copy the .aod file for the current layer from the source system to the Old folder.

Some layers have been renamed in Microsoft Dynamics AX 2012. Rename each .aod file to the new
name of the layer in Microsoft Dynamics AX 2012. The following table shows the names of the layers

in different versions of Microsoft Dynamics AX.

/

Microsoft Dynamics AX 4.0 layer Microsoft Dynamics AX 2009 Microsoft Dynamics AX 2012
layer layer (Rename to this)
axbup.aod axbup.aod axisp.aod
axbus.aod axbus.aod axisv.aod
axlop.aod axsl3.aod axslp.aod
axlos.aod axsl2.aod axsin.aod
axdip.aod axsll.aod axfpp.aod
axdis.aod axhfx.aod axfpk.aod
4. Inthe Import layer AOD into the baseline model store  dialog box, select the name of the .aod file

that you want to import. When you import layer files, you must start with the lowest layer.

5. Click OK to import the .aod file.

If the .aod file contains items that cannot be imported, an Infolog message is displayed. For more
information, see the log file referenced in the message. Usually, an application object cannot be
imported because of one of the followi ng reasons:

1 A method was added to a class that no longer exists in the Application Object Tree (AOT).
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1 There is an ID conflict between two elements that have the same name and type, but different IDs.
1 You customized a hybrid class or a table that supports inheritance.

To resolve these issues, identify all the application objects that were not imported from your
Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system. Export these application objects
to an .xpo file. Then import the .xpo file into the Microsoft Dynamics AX 2012 system by clicking
Import on the AOT toolbar.

In the code upgrade checklist, continue with the next steps for the layer file that you imported. Then
return to this procedure when you are ready to import the next layer file.

Impo rtant:
You must import Microsoft-owned models before other models. Then import the remaining models
one at a time, starting with the lowest layer.

Import AOD files into the new model store

Import the .aod file for the layer that you want to upgrade from th e source system into the new model
store.

Use the following procedure to import .aod files into the new model store.

1.

66

Copy the .aod file for the current layer from the source system to the following folder:
%ProgramFiles%Microsoft Dynamics
AX\60\ServeirMicrosoftDynamicsAX\ bin\Application\Appl\Standard

Do not copy the .aod files for the layers that Microsoft owns into this folder.

Some layers have been renamed in Microsoft Dynamics AX 2012. Rename the .aod file to the new
name of the layer in Microsoft Dynamics AX 2012. The following table shows the names of the layers
in different versions of Microsoft Dynamics AX.

Microsoft Dynamics AX 4.0 layer Microsoft Dynamics AX 2009 Microsoft Dynamics AX 2012
layer layer(Rename to this)
axbup.aod axbup.aod axisp.add
axbus.aod axbus.aod axisv.aod
axlop.aod axsl3.aod axslp.aod
axlos.aod axsl2.aod axsin.aod
axdip.aod axsll.aod axfpp.aod
axdis.aod axhfx.aod axfpk.aod

In the Import layer AOD into the new model store  dialog box, select the name of the .aod file that
you want to import. When you import layer files, you must start with the lowest layer. However, do
not import the layers that Microsoft owns into the new model store.

Select the model that you want to import the .aod file into.
Click OK to import the .ao d file.

If the .aod file contains items that cannot be imported, An Infolog message is displayed. For more
information, see the log file referenced in the message. Usually, an application object cannot be
imported because of one of the following reasons:

1 A method was added to a class that no longer exists in the Application Object Tree (AOT).
1 There is an ID conflict between two elements that have the same name and type, but different IDs.
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1 You customized a hybrid class or a table that supports inheritance.

To resolve these issues, identify all the application objects that were not imported from your
Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system. Export these application objects
to an .xpo file. Then import this .xpo file into the Microsoft Dy namics AX 2012 system by clicking
Import on the AOT toolbar.

In the code upgrade checklist, continue with the next steps for the layer file that you imported. Then
return to this procedure when you are ready to import the layer file for the next layer. You can then
import the remaining layers one at a time, starting with the lowest layer.

Import label files into the new model store

Import custom label files, or .ald files, into the new model store.

Use the following procedure to import label files into the new model store.

1.

On the Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 source system, create a label file
for the layer that you are importing by using the Label File Wizard . Then copy the label file to the
Microsoft Dynamics AX 2012 system.

In the Select file dialog box, select the name of the label file that you want to import. You must select
the label file that corresponds to the .aod file that you imported in the previous step of the code
upgrade checkilist.

Click OK to import the label file.

In the code upgrade checklist, continue with the next steps for the label file that you imported. Then
return to this procedure when you are ready to import the next label file. You can then import the
remaining layers one at a time, starting with the lowe st layer.

Import layer model(s) into baseline model store

Import all of the model files for a given layer into the baseline model store by using the AxUtil command -
line utility.

Use the following procedure to import a layer model into the baseline model s tore.

1.

On the source system, export all models for the current layer by using the axutil export command-line
utility. For example, to export the USR model, type the following command:

AxULtil export /model:"USR Model" ffile:"UsrModel.axmodel”
For more information about the AxUtil export utility, see the help for AxUtil. Type AxULtil /2.

On the target system, import all models from the previous step into the baseline model store by using
the AxUtil import command-line utility. For example, to import the model f rom the previous step into
the MicrosoftDynamicsAXBaseline model store, type the following command:

AxULtil import /file:"UsrModel.axmodel" /db:MicrosoftDynamicsAXBaseline
For more information about the AxUtil import utility, see the help for AxUtil. Type AxUtil /2.

After you have imported all models for the current layer, continue with the next steps in the code
upgrade checklist. Then return to this step when you are ready to import the models for the next
highest layer.

Important:
You must import Microsoft-owned models before other models. Then import the remaining models
one at a time, starting with the lowest layer.
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Import layer model(s) into new model store

For a given layer, import the files for the layer model into the new model store by using t he AxUtil
command-line utility.

Use the following procedure to import a layer model into the new model store.
1. On the source system, export all models for the current layer by using the AxUtil export command-
line utility. For example, to export the USR model, type the following command:
AxULil export /model:"USR Model" ffile:"UsrModel.axmodel"
For more information about the AxUtil export utility, see the Help for AxUtil. Type AxUtil /2.

2. On the target system, import all models from the previous step into the new model store by using the
AxUtil import command-line utility. For example, to import the model from the previous step into the
MicrosoftDynamicsAX model store, type the following command:

AxUtil import /file:"UsrModel.axmodel” /db:MicrosoftDynamicsAX
For more information about the AxUtil import utility, see the Help for AxUtil. Type AxULtil /2.

3. After you have imported all models for the current layer, continue with the next steps in the Code
upgrade checklist. Then, return to this step when you are ready to import the models for the next
highest layer.

0 Important:
You must import Microsoft-owned models before other models. Then import the remaining models
one at a time, starting with the lowest layer.

Restart Application Object Server

Restart the Application Object Server (AOS) when you have finished importing a layer.

Restart the AOS as follows during code upgrade:

1. When you have finished importing the layer, restart the Application Object Server (AOS).

2. When the AOS has restarted, continue with the next stepsin the code upgrade checklist. Then, return
to this step when you are ready to import the next highest layer.

Compile the application (upgrade)

When the Microsoft Dynamics AX application is compiled, its source code is translated into a machine-
readable format that can be interpreted by the Microsoft Dynamics AX server and clients. You compile the
application to ensure that all object references are updated and the application is ready to use.

This task is optional in the Data upgrade checklist . However,to prevent unexpected program behavior,
we advise you to compile all of your code after code upgrade.

0 Important:
Depending on your hardware, compilation can take an hour or more. It is critical to let
compilation run until it is complete.
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Detect code upgr ade conflicts

Create an upgrade project that contains objects that have conflicts because of modifications or updates.
The project contains objects that have been changed both in the new release and in your application
object layer.

Creating an upgrade pro ject

1. From the Microsoft Dynamics AX developer workspace, clickTools > Code upgrade > Detect code
upgrade conflicts .

2. SelectCreate layer conflict project

3. (Optional) To create separate projects for conflicting record IDs and table IDs, selectCreate
framework conflict project or projects , and then select the Record and table ID references check
boxes.

4. Click OK.
One or more new upgrade projects are created.

Alternatives to the Detect code upgrade conflicts tool

Instead of using the Detect code up grade conflicts tool, you can use the Compare layers tool to
compare any two layers. You can also use theCompare layers tool to create a project that contains the
objects that differ.

M Note:
When you use the Detect code upgrade conflicts tool, you can delete duplicates. However, you
cannot delete duplicates when you use the Compare layers tool. Therefore, the Compare layers
tool may be more useful as a general tool, for example, to provide an overview of the
modifications that were made in a certain layer.

During the upgrade, you can use the Project filter tool instead of both the Detect code upgrade

conflicts tool and the Compare layers tool. You can use the Project filter tool to create a project that is
based on criteria that you specify in a query form. For example, the project can contain all objects that are
from a specific layer, all objects that have a specific prefix, or all objects that were created by a specific

user.

Compile into .NET Framework CIL

The Compile into .NET Framework CIL task convers your compiled application code into Common
Intermediate Language (CIL) code that can be consumed by the Microsoft.NET Framework.

The purpose of CIL

CIL is the bytecode language that the just-in-time (JIT) compiler of the .NET Framework interprets.
Microsoft Dynamics AX converts compiled X++ code, or p-code, to CIL. This conversion provides
interoperability with .NET classes, and it also improves performance. The following Microsoft Dynamics AX
components rely on the speed of CIL:

1 Batch jobs
1 Application Integration Framework (AlF) and services
1 Runras scenarios, in which .NET functions are substituted for X++ functions at run time
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Scenarios that require the CIL task
You may have to run the Compile into .NET Framework CIL task in the following two scenarios:

1 You are installing Microsoft Dynamics AX, and you encounter the task in the Initialization checklist

1 You are performing an upgrade on a Microsoft Dynamics AX system that includes customized
application code, and you encounter the task in either the AOD code upgrade checklist or the
Model code upgrade checklist

0 Important:
In all checklists that include the Compile into .NET Framework CIL task, the previous task is
Compile application . You must complete the Compile application task before you can perform
the Compile into .NET Framework CIL task.

Perform data upgrade

Data upgrade on your Microsoft Dynamics AX target system completes the upgrade process. During data
upgrade, preprocessed data from your source system will be bulk-copied to the target system and
imported into the new Microsoft Dynamics AX database.

Open the Data upgrade checklist

The tasks that are involved in data upgrade are collected in the Data upgrade checklist . The checklist can
be opened by clicking System administration > Setup > Checklists > Data upgrade checklist .
Alternatively, you can select the Data upgrade checklist option in the Select the appropriate upgrade
checklist form. This form opens automatically on any newly installed system where data upgrade has not
been completed.

Complete the data upgrade tasks

The rest of this section describes the tasks that you must complete to import and upgrade your data on
the target system.

Provide license information

Set customer feedback options
Connect to source database

Set current time zone
Presynchronize (upgrade)

Create tables

Generate table mappings

Generate upgrade task prioritization
Launch data upgrade

Post journal for relief of legacy accrual of unmatched quantities
Configure system accounts

Finalize Enterprise Portal upgrade
Specify Role Center web site
Assign a primary address to paties
Upgrade services and AlF
Compare data upgrade row counts
Upagrade additional features

B B R R B R R R R e R |
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Provide lic ense information

To be able to use Microsoft Dynamics AX, the administrator must enter license information. By entering
license codes, you enable the general functionality covered by the license. Then, you can enable or disable
access to more specific featires by changing configuration keys.

A Note:
If you change the current license settings because license keys are updated, the new functionality
will not be available until the client is restarted.

In addition to license codes for Microsoft Dynamics AX functionality, there are licenses for access to the
Microsoft Dynamics AX development environment. For more information, see the Developer Help,
available from the Microsoft Dynamics AX Help menu.

If you do not have a license, you can set up Microsoft Dynamics AX in demonstration mode.
Demonstration mode provides all the functionality of Microsoft Dynamics AX, and enables all
configuration keys by default.

Language -specific licenses
If your license includes specific languages, you must restart the AOS after inporting the license file or

entering license information. Restarting the AOS ensures that the correct languages are listed in the
Options form (Microsoft Dynamics AX > Tools > Options...).

If you do not restart the AOS, end users will be able select unliensed languages, which would prevent the
Microsoft Dynamics AX client from starting.

Import license information

1. License information

2. Click Load license file to import the license codes from a file.
The Load license file dialog box appears.

3. Click the folder icon and browse for the license file.

@ Note:
We recommend that you store the license file in a secure location that is known only to
Microsoft Dynamics AX administrators.

4. Click OK. A message appears, asking whether you want to synchronize thedatabase.
Click Yes.
6. Close the License information window.

o

Enter license information

As an alternative to importing the license information, you can enter the license information manually.

1. License information

2. Enter the name of the license holder, the system's serial number, and the expiration date. The
information is in the license document.

3. Onthe System tab, enter the license code and verify that the Status field displays the expected text.
The license code indicates whether you have a sandard, professional, or enterprise solution.
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0 Important:
The first four entries (name of the license holder, the system's serial number, expiration date,
and license code) determine what appears in the remaining codes. Therefore, they must be
entered correctly.

4. Enter the remaining codes.
For each, review theStatus field to make sure that the code is accepted.

Set customer feedback options

Open the Microsoft Dynamics AX customer feedback options  form from the initialization the Data
upgrade checklis t.

Join the Customer Experience Improvement Program to help improve the quality, reliability, and
performance of Microsoft software and services.

The program collects information about computer hardware and how you use Microsoft Dynamics AX,
without inte rrupting you. This helps Microsoft identify which Microsoft Dynamics AX features to improve.
No information collected is used to identify or contact you.

For more information and a complete privacy statement for the Customer Experience Improvement
Program, visit the Customer Experience Improvement Program Web site

Connect to source database

The Connect to source database task in the Data upgrade checklist establishes a connection between
the Microsoft D ynamics AX source system database and the target system database. After you make this
connection, you can begin preparing the target database for the bulk -copy operation that occurs during
data upgrade.

Configure matching user permissions

Windows integrated security is used to connect to the source database from the target system. If the
administrative user who is performing the upgrade on the target system does not have access to the
source system database, the source system will reject the database conneton. Open Microsoft SQL
Server Management Studio on the source system and perform the following steps:

1. Grant Microsoft Dynamics AX database access to a domain user with administrative privileges on the
target Microsoft Dynamics AX 2012 system.
2. Add the user to the db_owner and public roles.

Connect to source database
Complete the following steps:

1. Inthe Data upgrade checklist , expand the Data upgrade group.
2. Click Connect to source database .
3. Inthe Connect to source database form, do the follo wing:

a. Inthe Server name field, type the name of the server and the Microsoft SQL Server database in
the format SERVE®ATABASE
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b. Inthe Database field, type the name of the Microsoft Dynamics AX source database instance, for
example, DynamicsAX5Q

4. Click OK.

The upgrade framework searches the network for the server and database that you specified. When the
computers connect successfully, thePresynchronize task becomes available in theData upgrade
checklist .

Set current time zone

Before you upgrade your data from Microsoft Dynamics AX 4.0, you must specify your local time zone.
This task opens theCurrent time zone form so that you can enter this information.

0 Important:
This checklist item applies only when you are upgrading from Microsoft Dynamics AX 4.0. The
Data upgrade checklist will always display this task prior to communication between the source
and target databases. At that point, the task disappears unless a Microsoft Dynamics AX 4.0
source system is detected.

The preferred method of storing date and time data in Microsoft Dynamics AX is Coordinated Universal
Time (UTC), as specified by the utcDateTime data type. During data upgrade, both shipped and custom
tables are scanned to identify system date and time fields. Your local time zone sdting determines the
offsets to apply to these fields when they are converted to UTC.

If custom date or time fields have been added to Microsoft Dynamics AX, you must decide whether those
fields should be merged into new utcDateTime fields during upgrade. For more information, see
Walkthrough: upgrading date and time table field pairs into UtcDateTime .

Presynchronize (upgrade)

When you perform the Presynchronize task in the target system, you use the Data upgrade cockpit (%1
-> 9%2) to run scripts that map the database schema on the source Microsoft Dynamics AX system to the
database schema on the target system. This tableto-table and column-to-column mapping is new with
Microsoft Dynamics AX 2012, and prepares the target database for synchronization. If liketo-like
mapping fails and errors result, you can manually repair the mapping and rerun the script.

Indexing is disabled while the presynchronization scripts are running.

The presynchronization scripts that ship with Microsoft Dynamics AX 2012 are meant to serve as models
for developers of new Microsoft Dynamics AX modules.

Prepare your database for synchronization as follows:

1. Inthe Data upgrade checklist , click Presynchronize . The Data upgrade cockpit (%1 -> %?2) opens
and lists the upgrade tasks to be completed.

2. ClickRun. IntheUpgradejob gri d, an icon next to each job indicate
presynchronization scripts run.

3. Address any errors that occur and then rerun the scripts.

Create tables

You perform the Create tables task to prepare the Microsoft Dynamics AX 2012 target database for
upgrade. During this step, the Microsoft Dynamics AX 2012 database schema is created based on
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Application Object Tree (AOT) definitions, including tables, unique clustered indexes, default constraints,
and views. (In previous releases of Microsoft Dynamics AX, the database schema was created during the
synchronization step.) Other indexes and check constraints arecreated on tables after bulk copy but
before the post-synchronization scripts run.

This task only creates the target database schema; no data is copied from the source system at this time.

0 Important:
Before you begin this task, use the Microsoft Dynamics AX Server Configuration Utility to confirm
that the AOS statement cache is set to 40.

1. Click Start > Administrative Tools > Microsoft Dynamics AX <version> Server Configuration
Utility > Database Tuning .

2. Locate the Statement cache field. Adjust the value if needed.

3. Click OK.

Create the target database schema as follows:

1. Inthe Data upgrade checklist , click Create tables.
The Synchronize table form displays a progress bar that indicates the status of the operation while
the upgrade framework queries the AOT and determines what tables, fields, and indexes to create in
the target database. This process may take several minutes to finish.

2. When the query process is finished, the Synchronize database form opens. Information that was
collected during the previous step is displayed on four tabs. You can select items to view details about
them.

Tab Description

Overview Shows what tables need to be created in the target database and summarizes the detailed results
provided on the other tabs.

Errors Lists errors that occurred while determining what tables to create. You must fix any errors before
you proceed with creating tables.

Warnings Lists all warnings about possible data conflicts that may arise after tables are created. You should
review the warnings and decide which of them require developer action.

Info Lists all the tables that will be created in the target database.

Address any errors or warnings before you continue with the data upgrade. Unresolved table errors
will cause the data upgrade to fail. After you verify that there are no errors or warnings, click
Continue on the Synchronize database form. The upgrade framework creates the tables in the
target database.

Generate table mappings

The Generate table mappings task in the Data upgra de checklist creates the mapping between the
tables and fields in the Microsoft Dynamics AX source database and the tables and fields that were
created in the Microsoft Dynamics AX 2012 database during the Create tables step in the Data upgrade
checklist .

Before you start the Generate table mappings task, you must complete the Data upgrade checklist
steps Connect to source database and Create tables. If any errors were generated in the Create tables
step, you must fix them before you proceed with mapping t he tables and fields, otherwise the mapping
will be incorrect.
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Generate table and field mappings

To generate mapping between tables and fields in the source and target databases, perform the following
steps:

1. Inthe Data upgrade checklist , click Generate table mappings .
The upgrade framework begins the mapping process and, when mapping is complete, opens the
Table mapping between source and target systems  form. This form provides separate tabs where
you can see all the tables and fields from the source daabase and how they are mapped to tables
and fields in the target database. You can also view a list of the extended data types that are used in
the source fields and have been brought into the target database.

2. Review the mapping on the Tables and Fields tabs in the form and note any errors.
3. Address mapping errors and rerun the Generate table mappings step.
0 Important:

If you encounter a mapping error, you may need to implement a presynchronization script that
defines a mapping for the source table and field. For more information, see the white paper How to
write upgrade scripts in Microsoft Dynamics AX 2012.

Customized solutions will frequently cause table mapping errors. For example, the addition of a new
extended data type will create an error for every table where it occurs. You will not be able to complete
upgrade until you write and implement presynchronization scripts to address schema differences you
have introduced.

For testing purposes, it is possible to perform an upgrade on the non -customized portions of your
installation and to ignore failed, customized tables using the Continue button on the Table mapping
between source and target systems form. The affected tables will not be copied, but the rest of the
upgrade can proceed.

You cannot proceed to the next Data upgrade checklist step, Generate upgrade task prioritization
until you address any errors in table and field mapping. If you do, data upgrade on the target sy stem will
fail.

Mapping errors

You may encounter the following table -mapping errors for tables that are listed on the Tables tab in the
Table mapping between source and target systems  form.

Status Description

OK Mapping for the table is complete without error.

No mapping defined Mapping has not been created because no applicable metadata was found in the
Microsoft Dynamics AX 2012 database.

Field error An error has occurred that resulted in a source field not being mapped to a target field.

The error could be that there is an inconsistency in the field data type, no field to import,
or a string-length difference in the field name.
You can see which fields have errors on theFields tab.

Mapping conflict Two source-database tables are mapped to the same target table. You must resolve the
conflict by renaming the table or assigning it a different ID.

Waiting on source A source table is still being used in preprocessing on the Microsoft Dynamics AX source
system.

Target table not empty The table that was aeated in the Microsoft Dynamics AX 2012 target database has data
in it. The source data cannot be copied into a table that already contains data. Clear all
data from the target table.
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Generate upgrade task prioritization

Use the Data upgrade checklist item Generate upgrade task prioritization  to plan the sequence of
bulk copy and post-synchronization script operations during data upgrade. Data upgrade takes place
while both the source system and the target system are in single-user mode. Consequently, busness
operations on Microsoft Dynamics AX are suspended during this time. Bulk copy and script operations,
which run concurrently to minimize system downtime, must be prioritized to make the most efficient use
of available processing capacity. Microsoft Dynamics AX uses a weighting algorithm to create a default
prioritization, though you can use the Prioritized upgrade scripts form to override default priorities as
needed to increase efficiency.

Determining task priorities

To preserve data integrity, upgrade tasks must be run in a certain sequence. Upgrade scripts cannot be
run until their associated tables have been copied to the Microsoft Dynamics AX target system, and large
tables with millions of records take longer than other tables to copy and process. Additionally,
dependencies among scripts can result in delays as one script waits for another to finish. ThePrioritized
upgrade scripts form analyzes all of the upgrade tasks and calculates a prioritization resulting in the least
downtime. The prioritization algorithm achieves this by assigning a weight to each task. The weight of a
table is based on its physical size and on the number of records. The weight of a script derives from the
weight of the tables it updates and on the cumulative weights of all its dependent scripts. In either case,
the highest weight results in the highest priority, since heavily weighted jobs are likely to block other jobs
until they finish running.

Weight-ranked results are displayed in grids on the Top tables and scripts tab. TheTop tables and
scripts field contains an integer value that specifies the number of tables and scripts that will be
processed concurrently during data upgrade. For example, a value of 20 means that a block of 20 tables
and a block of 20 scripts will be run concurrently before proceeding to the next block of 20 and 20. You
may achieve efficiency gains by overriding the default value of the Top tables and scripts field. This field
also determines the number of top tables and top scripts displayed in the ir respective grids.

In most cases, the ranking algorithm will produce the best prioritization. However, you can override the
algorithm by manually assigning higher or lower weights to tables or scripts and then regenerating the
prioritization. Custom pri orities are useful when you have knowledge of the actual loads that your system

will encounter while upgrading certain tables.

olmportant:
When you are regenerating the prioritization after ac
dialog asks to overwrite your customization.

Adding new tasks

The Prioritized upgrade scripts  form allows to you to add tables or scripts to the grids manually. To
insert an additional table or script, press Ctrl+F3 to create a new row, and then fill in the table or script
information. This method can also be used to override the calculated weight of an existing table or script
that is not displayed in its grid:

1. Press Ctrl+F3 to create a new row.
2. Enter the name of the table or script whose weight you wish to change.
3. Enter a custom weight.
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Launch data upgrade

The Launch data upgrade task opens the Data upgrade cockpit (%1 -> %2), where you can begin bulk
copying data from the source Microsoft Dynamics AX system and running data upgrade scripts on the
target system.

Run bul k copy and scripts

In the Data upgrade cockpit (%1 -> %?2), click Run to perform the bulk copy, run post -synchronization
scripts on the copied data, and create check constraints and indexes.

@ Warning:
Prior to this point in the upgrade process, it has been possible to keep the source system online.
Beginning with this step, you must enter single-user mode on both your source and target
systems, making them unavailable to regular users.

Post journal for relief of legacy accrual of unmatched quantities

Use this procedure to post a journal that relieves any legacy accrual accounting entries that still remain for
unmatched quantities. Unmatched quantities are quantities of purchased products that are received but
not yet invoiced. Select the journal name that you have defined during the pre -processing upgrade. After
you select the name, post the journal.

Post the journal

1. Check that the journal name is correctly displayed in the Task description field, and then click OK to
post the journal. To set up a batch job to post the journal, select a batch group to associate the
journal with in the Batch group field and then follow the rest of this procedure.

2. Click Private if you want to make sure that only the user who set up the batch job can run it.

Click Batch processin g if you want to run the task as a batch job.

4. Click Recurrence and Alerts to define the frequency of the batch job, and whether any alerts should
be defined for the job.

5. Click OK to post the journal or start the batch job.

w

Configure system accounts

Use the System service accounts form to configure the accounts used to run Microsoft Dynamics AX
services. Service accounts include the Business Connector proxy account, the Workflow system account,
the Workflow execution account, the synchronization service account, and the Bing Maps account.

Configure the Business Connector proxy account

In the Alias and Network domain fields, enter the user name and domain for the Business Connector
proxy account. The Business Connector proxy account is used for communication letween Microsoft
Dynamics AX and other applications.

For more information about the requirements for this account, see Specify the .NET Business Connector
proxy account.
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Configure th e Workflow execution account

The Workflow execution account is used for running application business logic and accessing Microsoft
Dynamics AX data. You can use one of the following accounts.

1 Enter a domain account in the Alias and Network domain fields to use a domain user for the
Workflow execution account.
1 Enter a new or existing Microsoft Dynamics AX user to access the database.

For more information about the requirements for this account, see Specify the workflow execution
account.

Configure the synchronization service account

The synchronization service account is used for communication between Microsoft Dynamics AX,
Windows Message Queuing, and Microsoft Project Server. You caruse one of the following accounts.

1 Enter a domain account in the Alias and Network domain fields to use a domain user for the
synchronization service account.

1 Enter a Microsoft Dynamics AX user for the synchronization service to communicate with. You can
associate the service with a new or existing Microsoft Dynamics AX user.

For more information about the requirements for the synchronization service account, see Create service
accounts.

Configure the Bing Maps account

The Bing Maps account is used to access the online Bing Maps when working in Enterprise Portal.
You can find the Bing Maps account name and password onCustomerSource

By selecting the check box and entering the information, you agree to be bound by the Microsoft Bing
Maps and MapPoint Web ServiceEnd User Terms of Use

Finalize Enterprise Portal upgrade

The upgrade process can cause the URLSs for various Microsoft Dynamics AX web pages to change in the
Application Object Tree (AOT). If you upgraded Enterprise Portal, you should select the option to Finalize
Enterprise Portal upgrade to make sure that the web pages are synchronized to use the correct URLS.

Specify Role Center web site

Microsoft Dynamics AX and the Enterprise Portal framework include customizable home pages calledRole
Centers Role Centers display specific data, reports, alerts, and common tasks tht are associated with a
user's role in the organization. Users can access Role Centers from the Microsoft Dynamics AX client or
from an Enterprise Portal web site.

Use this information to specify which web site will host the Role Centers.

1. Click the option to Specify Role Center website in the Data upgrade checklist . The Administration
of Web sites form opens.

2. Locate the Website used to display Role Centers in the client  field at the bottom of this form.

3. Select a site by using the lookup icon to the right of the field and then close the form. If you are not
certain which site should host Role Centers, skip this step. You can select the site later by using this
form.
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4. If no web sites are listed in this form, Enterprise Portal has not been instaled or an Enterprise Portal
web site has not been created. To learn more, see "Install Enterprise Portal and Role Centers" in the
Microsoft Dynamics AX 2012 Installation Guide.

Assign a primary ad dress to parties

If a party or customer has been associated with one or more addresses, it is required in Microsoft
Dynamics AX 2012 that one address be designated as a primary address. You are not required to define
an address for a party. Use this form 1o assign the first listed address for the party or customer as the
primary address when upgrading from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009.

1. From the Data upgrade checklist click Assign primary addresses to parties to open the Parties
without primary addresses  form.

2. Review the list of parties. You can manually select the address that you want to designate as the
primary address by navigating to the party record.

3. Click the Update addresses button to designate the first address as the primary address for all of the
parties that display in the list.

Upgrade services and AlF

Application Integration Framework (AIF) is used to exchange data between Microsoft Dynamics AX and
external systems. During the upgrade process, theData upgrade checklist includes a step for the
upgrade of AIF code. This topic describes this step of theData upgrade checklist .

Then, in the checklist pane, clickUpgrade AIF code . This step may take a while. When the step is
completed, check the Infolog to verify that no errors occurred. This step includes the following two
processes:

1 Code upgrade & This process creates new service classes, data classes, and service nodes in the
Application Object Tree (AOT).
1 Data upgrade & This process upgrades all AlFrelated records in the database.

0 Important:
The upgrade of AIF code and data is a two step process. You must successfully upgrade the AlF
code before you can upgrade the AIF data. For more information, see Upgrade additional
features.

Before you upgrade

Before you upgrade, you should be familiar with services and AIF. For more information, seeWhat's New:
Services and AlF

Review the following sections before you begin the upgrade process.

Process messages on the source system

Before you run the upgrade process, make sure that all the AIF messages have been processed on the

system that is being upgraded. Check the following locations to verify that all the messages have been

processed:

1 Allinbound message locations & These locations include file system directories, Message Queuing
gueues, and any locations where AIF receives inbound messages.

1 The queue manager & All messages in the queue manager are unprocessed and must be deleted.
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Upgrade considerations

The enhancements to services and AIF in Microsoft Dynamics AX 2012 cause significant changes in
functionality, configuration, database schemas, and document schemas, or .xsd files. When you f@n an
upgrade from an earlier version of Microsoft Dynamics AX, consider the following guidelines:

1 You must recompile and test all interfaces that used the earlier version of Microsoft Dynamics AX to
make sure that the interfaces work with services in Microsoft Dynamics AX 2012.
1 In Microsoft Dynamics AX 2012, the MSMQ and BizTalk adapters are replaced with equivalent

functionality that is provided by Windows Communication Foundation (WCF). You must recompile any

automated integration processes that used these adapters, such as Microsoft BizTalk Server
orchestration.

1 The upgrade framework changes AlF endpoints and related configurations to integration ports in
Microsoft Dynamics AX 2012. When the upgrade process is completed, you must configure these
integration ports before you can use Microsoft Dynamics AX 2012 services and AIF functionality.

Upgrade AIF code
This section describes the process that Microsoft Dynamics AX 2012 uses to upgrade AlF code.

Code upgrade
The step for the upgrade of AIF code upgrades existing Axd <Document> classes and methods. During
the code upgrade, the following classes are upgraded:

1 The Axd <Document> classes that are included with Microsoft Dynamics AX
1 Custom Axd <Document> classes
1 Custom classes that implement the AifServica  ble interface

Data upgrade

During the data upgrade, AlF data in the Microsoft Dynamics AX database is upgraded. Configuration
settings for AIF endpoints are copied to configuration settings for integration ports.

Changes made during upgrade

The following table describes how key concepts and configuration settings change when you upgrade
from Microsoft Dynamics AX 2009 to Microsoft Dynamics AX 2012.
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Microsoft Dynamics AX 2009
feature

Microsoft Dynamics AX 2012
feature

Description

AIF endpoints

Integration ports

The concept of integration ports
replaces the concept of AIF endpoints.
The Inbound ports form and the
Outbound ports  form replace the AIF
configuration forms. Endpoints that
exposed the Microsoft Dynamics AX
functionality are converted to inbound
integration ports. Endpoints that
submitted messages are converted to
outbound integration ports.

AIF endpoints become integration ports
that have a similar name. The upgrade
framework combines the endpoint
name and the company name to create
the name of the integration port. For
example, an endpoint in CompanyB that
is named EndpointA becomes an
integration port that is named
EndpointACompanyB.

Endpoint constraints

This feature is not converted.

Information about endpoint constraints
is not copied to Micr osoft Dynamics AX
2012. You must use the legal values
framework and the forms for inbound
and outbound integration ports to
configure constraints. Configure each
integration port to apply service and
parameter restrictions.

Endpoint data and action policies

The schema and operation
constraints are applied to the
integration ports.

Information about data and action
policies is not copied. In Microsoft
Dynamics AX 2009, data and action
policies were applied at the action level.
In Microsoft Dynamics AX 2012,data
and action policies are applied at the
level of the integration port. Therefore,
you must use the forms for inbound and
outbound integration ports to define
your data and action policies after the
upgrade.

|j Note:

In earlier versions of Microsoft
Dynamics AX, you were
required to assign data policies
to each endpoint action policy.
In Microsoft Dynamics AX
2012, the configuration of data
policies is optional.
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Microsoft Dynamics AX 2009
feature

Microsoft Dynamics AX 2012
feature

Description

AIF adapters

Integration ports

Information about AIF adapters is not
copied. Use the forms for integration
ports to associate adapters with
integration ports.

AIF channels

Address of integration ports

Information about AIF channels is not
copied. Use the forms for inbound and
outbound integration ports to configure
the address and response addess for
each integration port.

In earlier versions of Microsoft Dynamics
AX, you could associate an endpoint
with multiple channels or addresses. In
Microsoft Dynamics AX 2012, each
integration port has one address for
inbound messages and one address for
responses.

AlF pipelines

Integration port pipelines

AIF pipelines are automatically
upgraded to integration port pipelines.

Service code attributes

Microsoft Dynamics AX 2012
services framework

During the upgrade process, the service
code is marked with the appropriate
attributes, such as create, read, or find.
This step enables the autoinference
feature in Microsoft Dynamics AX 2012
to work with the upgraded code.

© Important:

You must configure each
upgraded service to assign
appropriate attributes. For
more information, see the next
row.

The configuration is always
company-specific.

By default, the configuration is not
company-specific.

In earlier versions of Microsoft Dynamics
AX, each AIF endpoint was associated
with a specific company. In Microsoft
Dynamics AX 2012, integration ports do
not have to be associated with a specific
company. However, you can use the
forms for inbound and outbound
integration ports to restrict service calls
to a specific company. For an inbound
message, the services framaork
retrieves the company ID from the
message header. If the message header
does not contain a company ID, the
services framework uses the default
company ID that is associated with the
user who submitted the message.
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After you upgrade

After you upgrade, you must configure the SysEntryPointAttribute attribute and validate the
migration of AIF endpoints.

Configure SysEntryPointAttribute

Microsoft Dynamics AX 2012 does not automatically assign the SysEntryPointAttribute attribute to
service classes that areupgraded. Follow these steps for each service that you are upgrading.

1. Inthe AOT, expand the Services node, and find the service that is being upgraded. Open the
Properties pane, find the corresponding class name for the service, and make a note of the class

name.

2. Inthe AOT, expand theClassesnode, and find the entry for the class that you found in the previous
step.

3. For each service operation in the class, add a&SysEntryPointAttribute attribute that uses a value

of true or false . We recommend that you set the value to true , so that the service operation
accepts the permissions that are assigned to it by the role-based security framework in Microsoft

Dynamics AX.
The following example code shows how to add the attribute to the create operation of the
SalesSalesOrderService class.

[AifDocumentCreateAttribute, SysEntryPointAttribute(true)]
public AifEntityKeyList create(SalesSalesOrder _salesSalesOrder)

{ return this.createList(_salesSalesOrder); }

Validate the migration of AlIF endpoints

Use the Microsoft Dynamics AX 2012 forms for inbound and outbound integration ports to validate and
configure the AIF endpoints that you migrated.

1. Open the Microsoft Dynamics AX client.
2. Initialize AIF to register adapters and services:
a. Click System admi nistration > Setup > Checklists > Initialization checklist
b. Expand thelnitialize system node.
c. Click Set up Application Integration Framework
3. Open each form for the configuration of integration ports:
a. Click System administration > Setup > Services and Application Integration Framework >
Inbound ports .
b. Click System administration > Setup > Services and Application Integration Framework >
Outbound ports .
4. Review the list of integration ports to make sure that the AIF endpoints have been migrated as
integration ports.
5. For each integration port, validate the migrated settings, and provide any settings that were not
migrated:
a. Inthe Address group, select an appropriate adapter in the Adapter field.
b. Click Configure to configure the adap ter that you selected.
c. Inthe URIfield, select an appropriate value for the URI.
d. Expose the service operations. SelecExpose service operations , and then click Service
operations .
e. Manually configure data policies and legal values. SelectCustomize documents , and then click
Data policies .
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f. Use the Processing options FastTab to configure processing settings. Processing settings include
settings that control the behavior when errors are encountered in a batch. These settings also
control the prep rocessing of requests and postprocessing of responses.

g. Use the Troubleshooting FastTab to configure troubleshooting settings. Troubleshooting
settings include settings that control the logging mode and the propagation of errors.

h. Use the Security FastTab to configure security settings. Security settings include settings that
control restrictions on authorized users and trusted intermediary users. These settings also control
whether the integration port is restricted to a specific company.

i. Inabrowser, open the Microsoft Dynamics AX Web service, and confirm that the Web server
returns the WSDL page. Use the following URL to open the Web service:
net.tcp:// AOS_SERVICE_HOBYnamicsAx/Services/ServiceNaméwsdl

A Note:
By default, Microsoft Dynamics AX uses port 8081.

For more information

For details about how to configure integration ports in services and AlF, see the documentation on the
TechNet web site.

Compare data upgrade row counts

The Compare data upgrade row counts task in the Data upgrade checklist checks the data integrity on
the Microsoft Dynamics AX 2012 target system following upgrade. Correctly correlated row counts among
the source, shadow, and target tables suggest, but do not confirm, that bulk copy and data upgrade
finished successfully.

@ Warning:
Row counts are only a preliminary check of data integrity. It is vital to perform more granular
checks on data integrity before putting your Microsoft Dynamics AX 2012 system into p roduction.

Compare source and target row counts

The Compare data upgrade row counts form displays related tables as records in a grid. It also provides
status figures that report possible problems. At a glance, you can compare table row counts across the
upgrade process starting with the source tables, passing to the shadow tables, and ending with the target
tables.

Row count is strictly a check onlikely success or failure of a table upgrade. When counts fail to match, you
should investigate the table involved and the script that processed it. However, even a successful match
does not guarantee that the upgrade was successful, and a failed match may not correspond to a
problem. To be confident that the upgrade succeeded, you must perform validation tailor ed to your
particular business data.

Upgrade additional features

The Upgrade additional features task in the Data upgrade checklist completes the upgrade process for
the Application Integration Framework (AlIF) and for business intelligence and reporting. When you click
the task, the Data upgrade cockpit (%1 -> %2) opens and displays a grid of upgrade jobs that you can
run.
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Run upgrade jobs
Select the jobs that you want to run and click Upgrade job .

Upgrade Enterprise Portal

This topic describes how to upgrade Enterprise Portal for Microsoft Dynamics AX. You must meet all of
the prerequisites and complete the procedures in this topic to upgrade an Enterprise Portal site to
Microsoft Dynamics AX 2012.

Important details about Enterprise Portal upgrades

This section describes the changes to Enterprise Portal data, code, pages, and other objects when you run
the Microsoft Dynamics AX 2012 Data upgrade checklist .

1 TheData upgrade checklist automatically upgrades Microsoft Dynamics AX 2009 ASP.NET pages to
Microsoft Dynamics AX 2012.

1 You can upgrade Enterprise Portal from Microsoft Dynamics AX 4.1 to Microsoft Dynamics AX 2012 by
using the procedures in this topic. However, the Enterprise Portal framework in Microsoft Dynamics
AX 4.1 supported X++ objects, whereas the Enterprise Portal framework in Microsoft Dynamics AX
2012 supports only ASP.NET objects, not X++ objects. After you upgrade to Microsoft Dynamics AX
2012, the Data upgrade checklist creates a list of all X++ objects that you must manually convert to
ASPNET before the objects can work with the Enterprise Portal framework in Microsoft Dynamics AX
2012.

I TheData upgrade checklist does not change any Enterprise Portal parameters.

I TheData upgrade checklist and Enterprise Portal Setup manage all changes to he Web.config file. If
your earlier implementation of Enterprise Portal was configured to connect to a different Application
Object Server (AOS) by using an .axc file, this configuration is upgraded automatically.

1 Enterprise Portal Setup automatically upgrades themes and style sheets. If you modified a style sheet
for your earlier implementation of Enterprise Portal, merge the changes when you run the Data
upgrade checklist , before you run Enterprise Portal Setup.

1 TheData upgrade checklist identifies proxy files and user controls that must be updated before they
can work with Enterprise Portal for Microsoft Dynamics AX 2012. You must resolve code differences in
the proxy files and recompile user controls so that the proxy files and user controls work with
Enterprise Portal.

1 Settings for end user personalization and customization of Enterprise Portal must be reset after the
upgrade.

Before you upgrade
You must complete the following tasks before you upgrade Enterprise Portal. Otherwise, the upgrade fails.

1. Use Internet Information Services (I11IS) manager to configure the site for Integrated Windows
authentication, or NTLM authentication. The upgrade process for Enterprise Portal fails if an Enterprise
Portal site is configured to use anonymous authentication. After the site is upgraded, you can
configure the site for anonymous authentication. For information about how to configure
authentication in 11S, see the online documentation for IIS.

2. You must complete the Microsoft Dynamics AX 2012 Data upgrade check list before you upgrade
Enterprise Portal. TheData upgrade checklist makes important changes to data and Enterprise Portal
objects. These changes are described later in this topic.
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3. If your Enterprise Portal sites are running Microsoft Dynamics AX 4.0 @ earlier versions, you must
upgrade to Microsoft Dynamics AX 4.1 before you can upgrade to Microsoft Dynamics AX 2012.

4. Enterprise Portal for Microsoft Dynamics AX 2012 requires either Microsoft SharePoint Foundation
2010 or Microsoft SharePoint Server2010. You must upgrade earlier versions of SharePoint to one of
these versions before you upgrade Enterprise Portal. For more information, seeUpgrading to
SharePoint Foundation 20100r Upgrading to SharePoint Server 2010

Upgrade Enterprise Portal

This section describes how to upgrade an Enterprise Portal site. You must complete the procedures in this
section in the following order:

1. Use SharePoint Central Administration to create a new Web application.

2. Install Enterprise Portal on the new Web application.

3. Attach the content database from your Microsoft Dynamics AX 2009 Enterprise Portal site to the new
Web application.

4. Resole URL conflicts.

5. Reinstall Enterprise Portal to start the code upgrade.

Create a new Web application

Use SharePoint 2010 Central Administration to create a new Web application. For more information, see
Create a Web application (SharePoint Server 201Q)

Install Enterprise Portal on the new Web application

Use the following procedure to install Enterprise Portal on the new Web application.

1. Start Microsoft Dynamics AX Setup.

2. Advance through the first wizard pages.

3. On the Modify Microsoft Dynamics AX installation page, selectAdd or modify components . Click
Next .

4. Onthe Add or modify components  page, expand Server Components , expand Web Server
Components , and then select Enterprise Port al (EP). ClickNext .

5. On the Specify Business Connector proxy account information  page, enter the domain\username
and password for the service account. ClickNext .

6. On the Configure a Web site for Enterprise Portal  page, select the existing Microsoft Dynamics AX
2009 Enterprise Portal site.

7. Select the Configure for Windows SharePoint Services  option so that Setup can configure the
application pool to run under the Business Connector proxy account. Setup can also set the
authentication method to Wind ows NTLM.

8. Clear the Create Web site option. If you select this option, Setup upgrades your Microsoft Dynamics
AX 2009 Enterprise Portal site and creates an additional site.

9. Onthe Ready to install page, click Install .

10. Complete the wizard. Setup can take up to one hour to complete the upgrade and installation.
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Attach the content database from your Microsoft Dynamics AX 2009

Enterprise Portal site to the new Web application

To retain content from an earlier version of Enterprise Portal and display that content in your Microsoft
Dynamics AX 2012Enterprise Portal site, you must attach the old content database to your new Web
application. For more information, see Attach databases and upgrade to SharePoint Server 2010

Resolve URL conflicts

If you specified a new port number or a new computer name when you created the new Web application,
the URL of the Enterprise Portal site was changed. If the URL has been changed, you must delete the old
site in the Microsoft Dynamics AX client by using the Web sites form.

After you delete the old site, click Register site , and then enter the information about the new site.
Repeat this process until you have registered each site. If you need help finding iformation about your
sites, open SharePoint Central Administration, and then clickApplication Management > View all site
collections . If necessary, use theWeb Application list to select the application that hosts your Enterprise
Portal sites.

Reinstall Enterprise Portal to upgrade the code

Reinstall Enterprise Portal on the new Web application so that the site upgrades the Enterprise Portal
code. Repeat the installation process that is described earlier in this topic.

After you upgrade Enterprise Portal
After the installation and upgrade are finished, follow these steps:

1. If you upgraded an Enterprise Portal site that uses anonymous authentication, and you configured the
site for Integrated Windows, or NTLM, authentication at the start of the upgrade pro cess, you can
now reconfigure the site for anonymous authentication. For information about how to configure
authentication, see the online documentation for IIS.

2. Verify that existing permissions for SharePoint and Microsoft Dynamics AX were retained duing the
upgrade process.

3. Test the upgraded site on a staging server before you move the site into a production environment.
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Test the system after upgrade

After you finish upgrade, test whether your Microsoft Dynamics AX 2012 installation is functioni ng

properly.

To test whether upgrade succeeded, perform (at a minimum) these tasks:

Restart all Application Object Server (AOS) instances.

Launch a client that is connected to each AOS instance that is running.

Test that users can execute the most commontasks for your system.

Test that the administrator can run the system maintenance tasks.

Test that developers can create a new development workspace and create code projects.

Test that users can execute the most vital tasks for your installation.

Test that users can read the reports that are generated.

Test that the security roles are working correctly. Users in Microsoft Dynamics AX 2012 should have

access to the data they had access to on the source system and they should be able to do all the tasks

for their assigned roles.

1 Validate that your Microsoft Dynamics AX 2012 data is consistent with the Microsoft Dynamics AX
source system data prior to upgrade.

1 Verify that features that required code upgrade function as expected on the new system.
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